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Communications and Safety Regulation Information

Compliance Statement
This model Digidesign Eleven Rack complies with the following 
standards regulating interference and EMC:
• FCC Part 15 Class B
• EN 55103-1 E1 Class B
• EN 55103-2 E1 Class B
• AS/NZS 3548 Class B
• CISPR 22 Class B

Radio and Television Interference
This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to Part 15 of the 
FCC Rules.

DECLARATION OF CONFORMITY

We Digidesign,

2001 Junipero Serra Boulevard, Suite 200

Daly City, CA 94014 USA

tel: 650-731-6300

declare under our sole responsibility that the product

Eleven Rack

complies with Part 15 of FCC Rules. 

Operation is subject to the following two conditions:  (1) this 
device may not cause harmful interference, and (2) this 
device must accept any interference received, including 
interference that may cause undesired operation.
Any modifications to the unit, unless expressly approved by 
Digidesign, could void the user's authority to operate the 
equipment.

Communication Statement
NOTE: This equipment has been tested and found to comply 
with the limits for a Class B digital device, pursuant to Part 
15 of the FCC Rules. These limits are designed to provide 
reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, 
and can radiate radio frequency energy and, if not installed 
and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, 
there is no guarantee that interference will not occur in a 
particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be 
determined by turning the equipment off and on, the user is 
encouraged to try and correct the interference by one or 
more of the following measures:
• Reorient or locate the receiving antenna.
• Increase the separation between the equipment and 

receiver.
• Connect the equipment into an outlet on a circuit 

different from that to which the receiver is connected.
• Consult the dealer or an experienced radio/TV technician 

for help.

Eleven Rack



CE Compliance Statement:

Digidesign is authorized to apply the CE (Conformité 
Europénne) mark on this compliant equipment thereby 
declaring conformity to EMC Directive 89/336/EEC and Low 
Voltage Directive 73/23/EEC.

Safety Statement
This equipment has been tested to comply with USA and 
Canadian safety certification in accordance with the 
specifications of UL Standards: UL60065 7th /IEC 60065 7th 
and Canadian CAN/CSA C22.2 60065:03. Digidesign Inc., has 
been authorized to apply the appropriate UL & CUL mark on its 
compliant equipment.

Warning

Important Safety Instructions

1) Read these instructions.

2) Keep these instructions.

3) Heed all warnings.

4) Follow all instructions.

5) Do not use this apparatus near water.

6) Clean only with dry cloth.

7) Do not block any ventilation openings. Install in accordance 
with the manufacturer’s instructions.

8) Do not install near any heat sources such as radiators, heat 
registers, stoves, or other apparatus (including amplifiers) that 
produce heat.
9) Do not defeat the safety purpose of the polarized or 
grounding-type plug. A polarized plug has two blades with one 
wider than the other. A grounding type plug has two blades and 
a third grounding prong. The wide blade or the third prong are 
provided for your safety. If the provided plug does not fit into 
your outlet, consult an electrician for replacement of the 
obsolete outlet.

10) Protect the power cord from being walked on or pinched 
particularly at plugs, convenience receptacles, and the point 
where they exit from the apparatus.

11) Only use attachments/accessories specified by the 
manufacturer.

12) Unplug this apparatus during lightning storms or when 
unused for long periods of time.

13) Refer all servicing to qualified service personnel. Servicing 
is required when the apparatus has been damaged in any way, 
such as power-supply cord or plug is damaged, liquid has been 
spilled or objects have fallen into the apparatus, the apparatus 
has been exposed to rain or moisture, does not operate 
normally, or has been dropped.

14) The apparatus shall not be exposed to drippings or 
splashing and no objects filled with liquids (such as vases) 
shall be placed on the apparatus.
Warning! To reduce the risk of fire or electric shock, do not 
expose this apparatus to rain or mositure.

15) The apparatus should be connected to a properly-grounded 
(earthed) receptable.

16) The mains switch is located on the front of the Eleven 
Rack. It should remain accessible after installation.
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Chapter 1: Introduction
Quick Start Instructions

You’ve Got Eleven Rack, You’ve 
Got Your Guitar. What’s Next?

Eleven Rack is a high-quality audio and MIDI in-
terface, with classic guitar amp and effects pro-
cessing built right in. This means that Eleven 
Rack is useful both when recording, and when 
playing guitar live or in practice.

At home or in the studio, you can plug guitars, 
microphones, and other instruments into 
Eleven Rack, and record directly into Pro Tools. 
You can use the amp and effects modelling ca-
pabilities of Eleven Rack to process signals as 
you record them, or to process previously re-
corded audio.

When away from the computer, you can use 
Eleven Rack as a standalone guitar processor, 
sending classic guitar tones straight to a venue’s 
PA system, to a guitar amp, or both. You can also 
simply plug in a pair of headphones and prac-
tice by yourself.

You’re probably excited to start playing with 
your new Eleven Rack right away, so let’s get 
started!
To get started playing guitar with Eleven Rack:

1  Connect outputs from Eleven Rack to your 
monitors or headphones:

• If you’re connecting to self-powered studio 
monitors, a stereo power amp and speakers, 
or mixer inputs, use the Main outputs.

– or –

• If you’re using a pair of headphones, con-
nect them to the Phones output.

2  Connect your guitar to the Guitar Input on 
the front panel of Eleven Rack.

Eleven Rack Main outputs (back panel) 

Phones output (front panel) 

Guitar input (front panel) 
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3  Connect the power cable and set the Power 
switch to On. The Eleven Rack logo will appear. 
As Eleven Rack warms up, check your guitar to 
make sure that its volume is turned up.

4  When the name of the first Rig is displayed, 
try playing your guitar. How’s it sound? You may 
want to adjust the output volume of Eleven Rack 
by turning the Volume knob on the front panel.

5  You can browse through Eleven Rack’s various 
preset sounds, called Rigs, by turning the Scroll 
wheel.

6  Try adjusting the lit Control Knobs to change 
the featured amp or effects settings. You can see 
what kind of control each knob is assigned to on 
the display.

7  Try pressing the Effects Bypass buttons, like 
Dist, Mod, Delay, and Rev, to toggle the various 
effects on and off.

Volume knob (front panel)

Scroll wheel (front panel)
Eleven Rack User Guide
System Requirements and 
Compatibility
To use Eleven Rack with Pro Tools, you need.

• One of the following:

• A qualified Mac or Windows computer 
(when using Eleven Rack with 
Pro Tools LE)

– or –

• A qualified Pro Tools|HDTM system run-
ning Pro Tools HD 8.0.1 software or higher 
(when using Eleven Rack as an external sig-
nal processing device)

• DVD drive for Installation disc

• Internet access for registration purposes

Avid can only assure compatibility and provide 
support for hardware and software it has tested 
and approved. 

For complete system requirements and a list of 
qualified computers, operating systems, hard 
drives, and third-party devices, refer to the latest 
information on the Digidesign website:

www.digidesign.com/compatibility



Getting Around This Guide
There are two main ways to use Eleven Rack. In 
Part 1, we’ll cover using Eleven Rack as a live gui-
tar processor, and in Part 2, we’ll get into how to 
use Eleven Rack as an audio and MIDI interface, 
and effects processor with Pro Tools.

Part 1: Eleven Rack for Guitar

You’re looking at it. In Part 1, we take you 
through the hardware features of Eleven Rack in 
Chapter 2, “Hardware Overview,” show you 
how to edit and create your own Rigs in 
Chapter 3, “Exploring Rigs,” and teach you how 
to use Eleven Rack as a live guitar processor in 
Chapter 4, “Eleven Rack Live Setup.”

Part 2: Working With Pro Tools LE

In Part 2, you can learn how to set up and use 
Eleven Rack as part of a Pro Tools system. We 
cover installation details in Chapter 5, “Install-
ing Pro Tools on Mac,” and Chapter 6, “Install-
ing Pro Tools On Windows,” setting up your stu-
dio in Chapter 8, “Eleven Rack Studio Setup,” 
and getting the most out of Eleven Rack with 
Pro Tools in Chapter 9, “Eleven Rack with Pro 
Tools.”

Part 3: Reference

In Part 3, we get into the technical details be-
hind the scenes. Learn all about Eleven Rack’s 
User Options in Chapter 10, “User Options,” 
and how to control Eleven Rack with MIDI in 
Chapter 11, “Controlling Eleven Rack with 
MIDI.” Hard drive setup for Pro Tools, general 
troubleshooting and how to get help with 
Eleven Rack are covered in Appendixes C, D, 
and E.
Conventions Used in This 
Guide
Digidesign guides use the following conven-
tions to indicate menu choices and key com-
mands:
:

The names of Commands, Options, and Settings 
that appear on-screen are in a different font.

The following symbols are used to highlight im-
portant information:

Convention Action

File > Save Choose Save from the File 
menu

Control+N Hold down the Control key 
and press the N key

Control-click Hold down the Control key 
and click the mouse but-
ton

Right-click Click with the right mouse 
button

User Tips are helpful hints for getting the 
most from your Pro Tools system.

Important Notices include information that 
could affect your data or the performance of 
your system.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
this guide and other Digidesign guides.
Chapter 1: Introduction 5
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Chapter 2: Hardware Overview

Eleven Rack Front Panel
Figure 1.  Eleven Rack front panel 
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The Eleven Rack front panel provides the follow-
ing: 

Power Switch

Use the heavy-duty Power switch to turn Eleven 
Rack on and off. Eleven Rack will take a few sec-
onds to warm up. When the Rig name appears 
on the display, you’re ready to rock.

Volume Knob

Turning the Volume knob will simultaneously 
adjust the output level of the Main outputs and 
the Headphone outputs.
Edit/Back and Save Buttons

Use the Edit/Back button to enter Rig View, 
which gives you access to the inner workings of 
the current Rig (preset). When in Rig View or 
any other special mode, press Edit/back to step 
backwards to the previous view. When you’re 
satisfied with the changes you’ve made, press 
the Save button to save your settings.

For more information on Rig View, see 
Chapter 3, “Exploring Rigs.”
Chapter 2: Hardware Overview 7
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User Options Mode

Hold the Edit/Back button to enter User Options 
mode, where many settings that change the be-
havior and configuration of Eleven Rack can be 
found.

SW1 and SW2 Buttons

Use the SW1 and SW2 buttons to toggle various 
switched behaviors and navigate through edit-
ing views in Eleven Rack. The part of the display 
next to the SW1 and SW2 buttons shows the 
current function of the buttons.

When one of the SW buttons are actively usable 
in the current screen, they will be lit.

Scroll Wheel

Use the Scroll wheel to browse through Rigs, 
and navigate through sections in Rig View, 
along with other miscellaneous scrolling tasks 
throughout Eleven Rack.

Effects Control Buttons

Use the Effects Control buttons to toggle effects 
on and off by type. Press and hold any of the ef-
fects buttons to access the controls for that ef-
fect. Pressing the FX1 and FX2 buttons simulta-
neously toggles the Wah effect on and off.

Tap Tempo/Tuner Button

Tap the Tap Tempo/Tuner button at quarter-
note intervals to set the current Rig’s FX tempo. 
Time-based effects like Delay and Tremolo can 
be set to synchronize with the new tempo. If 
you want to save the new tempo setting with 
the current Rig, press the Save button.

For information on User Options mode, see 
Chapter 10, “User Options.”
Eleven Rack User Guide
To access the built-in guitar tuner, hold the Tap 
Tempo/Tuner button down for one second. The 
display shows the Tuner view.

The guitar signal can be muted by pressing SW1. 
The reference pitch can be adjusted by turning 
the lit Control knob. 

When you’re finished tuning, press any button 
to return to the previous screen.

Mic Input and Controls

Use the Mic input to record and/or process mic-
level signals. Controls for preamp gain, phan-
tom power, and pad are provided.

About Phantom Power

Dynamic microphones (such as a Shure SM57) 
do not require phantom power, but are not 
harmed by it. Most condenser microphones (like 
an AKG C3000) do require phantom power to 
operate. 

If you are not sure about the phantom power re-
quirements for your microphone, consult your 
microphone’s documentation or contact the 
manufacturer.

Tuner view

Although phantom power is safe for most 
microphones, it is possible to damage some 
ribbon mics with it. Always turn off phan-
tom power and wait at least ten seconds be-
fore connecting or disconnecting a ribbon 
microphone.



Control Knobs

Use the Control knobs to access amp and effects 
controls, as well as other settings throughout 
Eleven Rack. The controls are pre-assigned, de-
pending on the current mode. The knobs light 
up in different colors, depending on their state:

Amber The current knob is assigned to an amp, 
cab, or FX loop parameter.

Green The current knob is assigned to an effects 
parameter.

Red The current knob is positioned differently 
than the assigned control’s saved position in the 
current Rig. You can match the knob position to 
the saved parameter by turning the knob until it 
lights Amber or Green again.

When a Control knob isn’t active in the current 
screen, it is not lit.

Phones Output

The Phones output is a 1/4-inch TRS jack that 
drives a pair of headphones with the same signal 
that is being sent out of the Main outputs of 
Eleven Rack. This can be either the output of the 
current Rig when using Eleven Rack, or the out-
put of Pro Tools or other applications when us-
ing Eleven Rack as an audio interface. 

The headphone output level is adjusted in tan-
dem with the Main volume when you turn the 
Volume knob on the front panel of Eleven Rack 
or adjust the Main volume from within 
Pro Tools. If you want the headphone volume to 
differ from that going to your speakers, you can 
adjust the Headphone Offset setting in User Op-
tions mode.

For more information on Headphone Offset, 
see“Headphone Volume” on page 94. 
Output To Amp 1 (L)

The Output To Amp 1 (L) is one of two outputs 
specifically designed for connecting to the input 
of a guitar amplifier. Since most amplifier input 
jacks are located on the amp’s front panel, we 
put one of these jacks on the front panel of 
Eleven Rack for easy patching. 

The other Output to Amp jack is located on the 
back of Eleven Rack. It can be used indepen-
dently of Output 1, or along with it for stereo 
amplifier configurations. The Output to Amp 
jacks can output a live guitar signal in real time 
as you play, or a pre-recorded signal from 
Pro Tools, for re-amping purposes. 

You can select from specific points in the signal 
chain to feed each Output To Amp jack. This lets 
you choose the amount of processing you want 
on the output signal.

Guitar Input with True-Z

The Guitar input is a 1/4” TS, instrument-level 
input. Designed for electric guitars, the jack also 
works well with bass and acoustic guitars with 
pickups, or even vintage electric pianos.

Eleven Rack features a special variable-imped-
ance circuit called True-Z, which automatically 
changes the input impedance of the Eleven Rack 
guitar input depending on which amp or effects 
model is first in the signal chain of the current 
Rig.

True-Z alters the frequency response of your gui-
tar signal by loading your pickups in the same 
manner as plugging into a real amp or effect. 
This feature can also be manually controlled 
and saved as part of a Rig setting.

Most recent keyboards have line-level out-
puts and should be connected to the Line in-
puts on the back panel of Eleven Rack.
Chapter 2: Hardware Overview 9
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Eleven Rack Back Panel
Figure 2 identifies each port on the back panel of the Eleven Rack. 
Eleven Rack User Guide
Figure 2.  Eleven Rack back panel
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The Eleven Rack back panel provides the 
following:

FX Loop I/O

The FX Loop I/O is a pair of 1/4-inch TRS inputs 
and outputs, which can be used to insert a mono 
or stereo external effects processor into the gui-
tar signal. A switch is provided to adjust the sig-
nal level to be suitable for either a line-level ef-
fects processor (Rack FX) or a guitar-level effects 
processors (Stompbox FX).

Main Outputs

The Main output section includes a stereo, XLR, 
line-level analog output pair. Connect these to 
studio monitors, a power amp, mixer, or PA sys-
tem.

The Gnd Lift switch is useful for suppressing 
hum in some situations, but should usually be 
left switched off unless it is really needed.
Output To Amp 2 (R)

The Output To Amp 2 (R) is one of two outputs 
specifically designed for connecting to the input 
of a guitar amplifier or effect. It can be used in-
dependently of Output 1 (located on the front 
panel), or along with it for stereo amplifier con-
figurations. 

Digital Inputs and Outputs

AES/EBU

The AES/EBU In and Out ports are balanced 
three-conductor XLR connectors that can run at 
up to 24-bit, 96 kHz resolution.

The AES/EBU format is used in many profes-
sional digital converters, recorders, and signal 
processors. 



S/PDIF

The S/PDIF In and Out ports are unbalanced 
two-conductor phono (RCA) connectors that 
can run at up to 24-bit, 96 kHz resolution.

The Sony/Philips Digital Interface Format 
(S/PDIF) is used in many professional and con-
sumer CD recorders and DAT recorders. To 
avoid RF interference, use 75-ohm coaxial cable 
for S/PDIF transfers and keep the cable length to 
a maximum of 10 meters. 

AC Power Input

The AC power input accepts a standard IEC 
power cable (one is included with Eleven Rack). 
The power supply in Eleven Rack is universal, so 
wherever you go, all you need is a standard IEC 
power cable with the correct plug for your re-
gion.

Line Inputs

The Line inputs accept one stereo or two mono 
line-level analog signals. The Level switch lets 
you choose between +4 or –10 dBV, for compat-
ibility with professional and consumer gear.

Eleven Rack can use either AES/EBU or 
S/PDIF, but not both at once. For informa-
tion on switching between digital formats, 
see “Digital Format” on page 58.
MIDI I/O

The MIDI In and MIDI Out ports are standard 
5-pin MIDI ports, each providing 16 channels of 
MIDI input or output. These ports can interface 
with a variety of MIDI devices

When Eleven Rack is used as a standalone pro-
cessor, the MIDI jacks are used to communicate 
with MIDI foot controllers, sending and receiv-
ing program changes and continuous controller 
data.

Exp Pedal/Ext Footswitch Input

The Exp Pedal/Ext Footswitch input supports an 
expression pedal or a momentary footswitch 
(single or dual). You can control sweepable pa-
rameters (like Wah, Volume and Multi FX) with 
an expression pedal, or switchable settings (like 
Rig switching, amp channel switching, and ef-
fects on/off) with a footswitch.
Chapter 2: Hardware Overview 11
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Chapter 3: Exploring Rigs
Overview
Eleven Rack is a powerful guitar signal processor 
that delivers the tone of a wide variety of ampli-
fiers, speaker cabinets, microphones, and effects 
units. The combination of all of this gear and 
their control settings make up a Rig.

Eleven Rack comes loaded with over 100 Rigs 
that showcase the range of tones our collection 
of amps and effects can achieve. The built-in 
Rigs are a good place to start, but the power of 
Eleven Rack really comes into play when you 
create your own.

You can audition, manage, edit and create Rigs 
right from the front panel of Eleven Rack. When 
using Eleven Rack with Pro Tools LE, the built-
in Eleven Rack Control window offers another 
convenient way to do this work.

For details on working with Rigs from 
within Pro Tools, see “The Eleven Rack 
Control Window” on page 76.
Rig Select Mode
When you turn on Eleven Rack, it’s already in 
Rig Select mode. In this mode, you can turn the 
Scroll wheel to select a Rig. Pressing the SW 1 
button will cycle the display through these three 
display modes:

• Default mode

• Simple mode

• Details mode

Default Mode

This mode shows the Rig number and name, 
and provides a set of amp or effects controls that 
you can change without entering Rig View. 
Chapter 3: Exploring Rigs 13



14
Simple Mode

This mode shows the Rig number and name in 
the largest type possible. Perfect for seeing from 
across a dark stage.

Details Mode

This mode lists the amp, cabinet, and effects 
models that are used in the current Rig, plus 
their on/off status.

Rig Organization

Eleven Rack has storage for 208 Rigs. Half of 
these are factory presets, and the other half are 
user-editable Rigs. You can also save and store 
an unlimited number of your favorite Rigs as 
plug-in settings files on your computer.

Rig name

Rig Bank

Rig number 
Eleven Rack User Guide
The 208 Rigs in Eleven Rack are arranged into 
two sets of 26 banks, each containing four Rigs. 
Each bank is marked with a letter, from A to Z. 
For example, the third preset in bank D is re-
ferred to as D3. Banks with lowercase letters are 
factory presets, and those with uppercase letters 
are the user banks.

User Rigs and Factory Rigs

By default, all 104 user Rigs are copies of the 104 
factory Rigs. This gives you a place to start when 
you set out to make your own Rigs. As you scroll 
through, notice that when you get past the end 
of the uppercase (user) Rigs, you’ll then begin to 
see the lowercase (preset) Rigs.

The user Rigs are yours to edit, change, copy, 
and mangle as you see fit. The preset Rigs will al-
ways stay the same. If you make changes to a 
preset Rig and want to save it, you can save it as 
a new User Rig.

Selecting Rigs Live
When using Eleven Rack in live performance sit-
uations, we recommend using a footswitch ac-
cessory or a dedicated MIDI foot controller to 
switch from Rig to Rig.

For information on using a footswitch ac-
cessory, see “External Pedals” on page 93, 
and see “Eleven Rack MIDI CC Controllers” 
on page 95 for information on using a MIDI 
foot controller.



What’s In A Rig?
Figure 3.  Eleven Rack Rig devices
Each Rig in Eleven Rack contains the following 
devices for processing your guitar signal, and 
each of them has settings you can control:

• Amplifier 

• Speaker cabinet and microphone

• Seven simultaneous effects (such as Wah, Dis-
tortion, Modulation, and Reverb)

• Volume pedal

• FX Loop

In addition, there are a group of “Utility” set-
tings in each Rig:

• Input, which lets you manipulate the True-Z 
input impedance circuitry

• Output, which lets you change the Rig vol-
ume, To Amp output volume, and switch the 
Rig output between mono and stereo

• Tempo, which lets you set the Rig tempo

• Pedal, which lets you configure an external 
footswitch or expression pedal accessory

• Display, which lets you set the device whose 
controls are displayed in Rig Select view (like 
Amp, Mod, or FX1)
Rig View
Rig View is a special editing mode you access by 
pressing the Edit/Back button on the front panel 
of Eleven Rack. When you’re done editing, press 
the Edit/Back button again to get back to the 
main Rig Select mode. 

In Rig View, you can access every aspect of the 
current Rig, from the amp, cabinet, and micro-
phone type, all the way to choosing effects, and 
changing their order in the signal chain.

Once you’ve entered Rig View, you’ll see a selec-
tion of icons, each representing a different de-
vice or utility setting within the current Rig. 
Turn the Scroll wheel to select the element you 
want to access.

As you scroll through the list, certain functions 
will be assigned to the lit Control Knobs, like 
choosing the type of amp or effect you want to 
use.

If you make changes you want to save, be 
sure to use the Save button before switching 
to a different Rig. For details, see “Saving 
Your Work” on page 19.

Rig View
Chapter 3: Exploring Rigs 15
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Page Indicator

In Eleven Rack’s editing screens, a Page indica-
tor appears on the display if there is more than 
one page of controls. The Page indicator shows 
the number of pages, as well as the name of the 
page you’re viewing. Turn the Scroll wheel to 
switch between pages.

Rig Device and Utility 
Settings in Rig View
This section describes the functions of the de-
vice and utility settings pages found in Rig View.

If the device or setting you select in Rig View has 
additional controls, pressing SW1 (labeled 
CONTROLS) takes you to a special Control page 
for that device. When you’re finished, press 
Edit/Back to go back to Rig View.

Amplifier, Cabinet, and 
Microphone

AMP

Turn the lit Control knob to select the type of 
simulated amp you want to use. Press CONTROLS 
to access additional amp settings.

CAB

Turn the lit Control knobs to select the type of 
cabinet and microphone you want to use. Press 
SW1 to bypass the cab and mic simulations. 
Press SW2 to toggle the microphone position on 
or off-axis. 

Page indicator, showing page two of four

For more details on working in Control 
pages, see “Control Pages” on page 19.
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Effects

VOL

Press CONTROLS to access a Control page where 
you can adjust the position and minimum vol-
ume of the Volume pedal, using the lit Control 
knobs.

WAH

Turn the lit Control knob to select the type of 
Wah pedal you want to use. Press CONTROLS to 
access a Control page, where you can adjust the 
position of the Wah pedal.

DIST

Turn the lit Control knob to select the type of 
Distortion effect you want to use. Press CON-
TROLS to access additional settings for the cho-
sen Distortion effect.

MOD

Turn the lit Control knob to select the type of 
Modulation effect you want to use. Press CON-
TROLS to access additional settings for the cho-
sen Modulation effect.

FX1 and FX2

The FX1 and FX2 pages let you choose two addi-
tional effects not found in the other categories 
(such as compressor or graphic EQ) as well as a 
variety of modulation effects, using the lit Con-
trol knob. Press CONTROLS to access additional 
settings for the chosen effect.

When playing Eleven Rack through a guitar 
amp, it is recommended that you bypass the 
Cab and Mic simulations. Unless the guitar 
amplifier has a very flat frequency response, 
its own speakers will affect the tone and 
make Cab and Mic simulation unneccessary.



REV

Turn the lit Control knob to select the type of 
Reverb effect you want to use. Press CONTROLS 
to access additional settings for the chosen Re-
verb effect.

DLY

Turn the lit Control knob to select the type of 
Delay effect you want to use. Press CONTROLS to 
access additional settings for the chosen Delay 
effect.

FX LOOP

Press CONTROLS to access a Control page where 
you can adjust the gain and blend settings of the 
FX Loop, using the lit Control knobs.

Utility Settings

INPUT

Turn the lit Control knob to manipulate the 
True-Z impedance circuitry in Eleven Rack. 
When set to Auto, the input impedance is deter-
mined by the first active effect or amp in the sig-
nal chain. You can also choose a specific load 
value to best match your pickups.

Effects and the FX Loop can be moved to 
different locations in the signal chain of the 
Rig. For that reason, when an effect or the 
FX Loop is selected in Rig View, SW2 is la-
beled MOVE. For more details, see “Signal 
Routing” on page 18.
OUTPUT

Turn the lit Control knob to set the output level 
of the Rig (known as the Rig volume). Press 
CONTROLS to access a Control page, where you 
can set the volume of the signals feeding the To 
Amp outputs. Press MONO to toggle between ste-
reo or mono output.

The Rig volume setting is a tonally transparent 
volume control, intended for making fine ad-
justments to the relative volume levels of differ-
ent Rigs. 

The To Amp output volume settings let you op-
timize signal level for the amp(s) or external pro-
cessors you are sending signal to. 

DISPLAY

Turn the lit Control knob to specify what con-
trols are displayed in the Default view of Rig Se-
lect mode.

TEMPO

Turn the lit Control knob to set the Rig tempo. 
Any amp or effects settings that have a control 
set to sync to a specific subdivision of Rig tempo 
will lock to this tempo.

Press MIDI to toggle sync of Rig tempo to incom-
ing MIDI clock (from the MIDI input of Eleven 
Rack) on or off. 

Press FINE to toggle fine tempo editing mode on 
or off. In this mode, turn the Scroll wheel to ad-
just the Rig tempo in tenths of a BPM, rather 
than the coarse adjustments that are made with 
the Control knob. Press FINE again to return to 
the normal mode.
Chapter 3: Exploring Rigs 17
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PEDAL

Turn the lit Control knob to choose the param-
eter controlled by an external expression pedal, 
if attached. The following choices are available:

Wah Lets you control the sweep of the Wah ef-
fect.

Volume Pedal Lets you control the sweep of the 
Volume Pedal effect.

Rig Volume Lets you control the overall Rig 
volume.

Multi FX Lets you control up to four different 
amp and/or effects parameters at once. Press 
FX-Sel for options. There are four pages of op-
tions, each one addressing one parameter that is 
to be controlled. 

On each page, set the device you want to control 
and the parameter you want to sweep. The Toe 
and Heel settings govern the range of the con-
trol that is able to be swept. 

None No parameter will be affected when the 
pedal is moved.

If you set the Heel number higher than the 
Toe number, the control can be swept in re-
verse.

For information on how to toggle 
Eleven Rack between expression pedal and 
footswitch control, see “External Pedals” on 
page 93.
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Signal Routing
The position of many of the devices in the signal 
chain can be changed. The order that effects 
units are plugged into each other can make a 
large difference in the sound you get.

Most effects can be moved anywhere before or 
after the amp and cabinet models. The FX Loop 
can be moved to one of four places; the begin-
ning of the chain, before the amp and cab, after 
the amp and cab, or before the final output.

To move an effect:

1  Turn the Scroll wheel to select the effect you 
want to move.

1  Press SW2 to enter Move mode.

2  Turn the Scroll wheel to move the effect to a 
different position in the signal chain.

3  Press SW2 again to keep the change, or SW1 to 
cancel the move.

Controls Takes you to a page with additional 
controls for the selected element. Press 
Edit/Back to return to Rig View when you’re fin-
ished. 

Move Lets you move an effect or the FX loop to 
a different point in the signal chain.



Control Pages
When there are additional controls available for 
the device or utility setting you’ve selected, 
pressing SW1 (labeled CONTROLS) takes you to a 
special editing screen for that device, called a 
Control page. 

The Control knobs that are assigned to controls 
in the current device will light amber, if you’re 
editing Amp, Cab, or FX Loop settings, or green, 
if you’re editing an effect. The display shows 
what parameter each knob is assigned to, and 
each knob’s current setting.

When you turn a knob away from its saved set-
ting, it will light red, to show you that the set-
ting has changed. If you want to return a control 
to its saved setting, turn the knob until it goes 
back to amber or green.

SW1 and SW2 are assigned to various functions, 
like BYPASS, which toggles the current element 
on and off, and other switched behaviors, like 
BRIGHT (bright switch) and TREMOLO (tremolo 
on/off). 

Control page for Green JRC OD effect

Individual effects may be toggled on and off 
at any time by pressing the corresponding 
Effects Control button on the front panel of 
Eleven Rack. The Wah effect can be toggled 
on and off by pressing FX1 and FX2 simul-
taneously.
If there is more than one page of controls avail-
able for the current device or utility setting, a 
Page indicator is displayed. Turn the scroll 
wheel to switch between pages. You can also use 
the Scroll wheel to scroll quickly through all of 
the Control pages in the current Rig.

When you’re finished editing, press Edit/Back to 
go back to Rig View.

Saving Your Work
When you’re done editing the current Rig, you 
may want to save its settings, or save the new 
settings to a different user Rig without affecting 
the current Rig.

Keep in mind, if you switch to another Rig be-
fore saving your work, the edits you’ve made 
will be lost.

To save the new settings to the current Rig:

1  Press the Save button. The display will show 
the Save View. 

2  Press Save again to save the updated settings 
to the current Rig.

Save page
Chapter 3: Exploring Rigs 19
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To create a new Rig with the new settings:

1  Press the Save button. The display will show 
the Save View. 

2  Turn the scroll wheel to select a preset Rig that 
you don’t mind overwriting. 

3  Choose a name for your new Rig, using the lit 
Control knobs and SW switches:

• The first lit knob moves the cursor from left 
to right.

• The second knob lets you choose an upper-
case letter from A-Z.

• The third knob lets you choose an lower-
case letter from a-z.

• The fourth knob lets you choose a number 
or symbol.

• SW1 lets you insert a space.

• SW2 lets you delete an unwanted character.

4  Press Save again to save the new Rig.

The Amps
This section takes you through all of the emu-
lated amplifiers available in Eleven Rack, and 
touches on any special features and controls 
each amp offers.
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‘59 Tweed Lux

Based on a classic late-50s tube combo amp with 
a single 12-inch speaker and a pair of 6V6 tubes 
delivering 15 watts, the ‘59 Tweed Lux model is 
the picture of vintage simplicity. With just a 
simple treble-cutting tone control, the Tweed 
Lux delivers crunchy clean sounds when used 
with single-coil pickups, and fat leads when 
driven with humbucking pickups. 

The inputs on this model are “jumped” so you 
can feed both the Instrument and Mic inputs in 
parallel.

’59 Tweed Bass

Based on a late-50s low-wattage tube bass 
combo amp, the ‘59 Tweed Bass model has a 
tight bass response and a warm, twang-friendly 
high-end. Along with controls for Bass, Middle 
(midrange), and Treble, a negative feedback 
Presence control also allows for more tweaking 
of the high-end frequencies. 

Just like the Tweed Lux, the Tweed Bass is also 
“jumped” so you can feed both the Bright and 
Normal inputs in parallel.



’64 Black Panel Lux Vibrato and 
Normal

The amp we based the ‘64 Black Panel Lux Vi-
brato and Normal models on is regarded by 
some as the ultimate small club amp. A 60s tube 
combo with a single 12-inch ceramic-magnet 
speaker and a pair of 6V6s putting out just over 
20 watts, this amp has long been a standard in 
the studio as well as onstage. 

At low volumes its crisp, clean high-end has 
been favored by country rockers, but push the 
amp past 7 with a humbucking pickup, and 
you’ve got an amazingly dynamic lead tone. For 
Eleven, we’ve modeled both channels of this 
classic blackface-era amp. 

The Lux Vibrato model has two gain stages and 
the tremolo effect is toggled using SW2. Lux 
Normal has a single gain stage and tremolo is al-
ways on, unless the Intensity control is rolled all 
the way off.
’66 AC Hi Boost

Originally released in 1958, the British amp we 
based our ‘66 AC Hi Boost model upon went 
through a few design changes that would even-
tually define the sound of British pop/rock in 
the ‘60s. 

First available as a modification mounted in the 
back of the amp, the “Top Boost” circuit added 
an extra tube and controls for Treble and Bass. It 
became so popular that it eventually became a 
part of the standard componentry of the amp. 

The glassy high-end and chime of the AC Hi 
Boost lends a classic propulsion to rhythm gui-
tar parts, and at higher gain settings, singing 
lead tones are a snap to achieve. 

For our model, we’ve “jumped” the Normal and 
Brilliant channels. The Cut (presence) control is 
active on both channels. However, just like the 
original, the Treble and Bass controls are only 
part of the Brilliant channel, and have no effect 
on the Normal channel. 

Go to the second Control page and press SW2 to 
toggle the tremolo on and off. 
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’67 Black Panel Duo

Without a doubt, the blackface-era amp we 
based our ‘67 Black Panel Duo model upon is 
considered one of the greatest combo amps ever 
made. With two 12-inch ceramic-magnet speak-
ers and a quartet of 6L6 tubes pushing 80 watts, 
no concert stage has been complete without one 
since it was introduced in the late 60s. 

One of the main reasons for the amp’s popular-
ity is that it can maintain classic vintage clean 
sounds even at high volume levels. Another spe-
cial Black Duo feature is the inclusion of a Bright 
switch. 

For our model, just like the original, as you turn 
the Volume knob up, the Bright switch has less 
of an effect. Dial the Volume knob around 3 or 4 
with the Bright switch on, and you’ll get that ul-
tra-clean snap that it’s famous for. 

On the first Control page, SW2 is set to toggle 
the Bright switch on and off. On the second 
page, SW2 toggles vibrato on and off.
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’69 Plexiglas

Based on one of the most highly sought-after 
high-volume amplifiers of the late 1960s, our 
‘69 Plexiglas model delivers no-nonsense British 
crunch. The original amp's dual 4x12 cabinets 
and 100-watt head offered unprecedented vol-
ume and power for the time, helping to usher in 
the era of the Guitar God.

For our model, we’ve based it on the legendary 
100-watt 1968/69 version. We’ve also “jumped” 
both channels, for further gain.

’82 Lead 800

Based on the early-80s descendent of the amp 
we based our Plexiglas model upon, the ‘82 Lead 
800 adds a higher-gain cascaded preamp design 
and a master volume control. Unlike the high-
volume heads of the 60s, which needed to be on 
10 to achieve an overdrive sound, this amp 
could conjure up real distortion at any volume 
level, and that made it very popular in the bur-
geoning 80s heavy metal scene. 



’85 M-2 Lead

Based on a classic mid-80s high-end tube combo 
amp, the ‘85 M-2 Lead model delivers hot-
rodded overdrive and searing solo tones. With a 
full complement of tone controls and indepen-
dent input volume, overdrive and master vol-
ume controls, the gain structure can be tweaked 
to your heart's content.

The M-2 Lead emulation is based on the lead 
channel with the fat, bright, and gain boost op-
tions on. 

‘89 SL100 Drive, Crunch, and 
Clean

Our ‘89 SL100 model is based on a late-80s high-
gain 100-watt tube head, which was popular for 
its singing sustain and clear articulation. The 
Bright switch on the Clean and Crunch models 
boosts the high-end for lead lines and cutting 
tones.

For the Drive model, we simulated a bright 
switch modification that was popular for this 
amp. Set to Normal, the amp is stock. With 
Bright engaged, the treble boost that would nor-
mally happen at lower gain settings is removed, 
which leads to a rounder, thicker sound. The 
Bright switch circuit has progressively less effect 
as the gain is raised, and no effect when the pre-
amp is set to 10.

Toggle the Bright switch on and off with the 
SW2 button.

’92 Treadplate Modern and 
Vintage

Released in 1989, the amp that inspired our ‘92 
Treadplate Modern and Vintage models seemed 
cooler than a high-performance racecar. With 
more tone-tweaking options and distortion 
than any amp before it, the amp became the in-
dustry standard for players looking to achieve a 
massive sound.

With the ability to run on either 6L6 or EL34 
tubes, this amp offered a choice between either 
tube or silicon diode rectifier circuits. On top of 
that, an AC power selection switch offered a 
Bold or a Spongy option, which would drop the 
voltage like a Variac for a more “brown” sound. 

For our Treadplate, we modeled two different 
channels and selected the appropriate rectifier 
and AC power switch setting. For Treadplate M 
(for Modern), we set it on the Red channel using 
6L6s, a silicon rectifier, and the Bold power set-
ting for a tight, aggressive tone. For Treadplate V 
(for Vintage), we modeled the orange channel 
with 6L6s, a tube rectifier, and the spongy power 
setting for a more fluid lead tone. 
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DC Modern Overdrive and DC 
Vintage Crunch

Rather than base these two models on any two 
specific amps, we blended the characteristics 
and features of many of our favorite amps to cre-
ate a couple of absolute monsters.

The Modern model augments a modified high-
gain British amp flavor with a Bright switch and 
classic American-style Tremolo. The Vintage 
model combines tonal attributes of 50s and 60s-
era American tube amps, with added gain poten-
tial and a Bright switch.

On the first Control page, SW2 is set to toggle 
the Bright switch on and off. On the second 
page, SW2 toggles vibrato on and off.

General Amp Controls
The Amp controls can be accessed in the Default 
view of Rig Select mode, or by selecting the AMP 
device in Rig View and pressing CONTROLS. 
There are two pages of controls for every amp. 
These controls are configured and named to 
closely match the amps we modeled for 
Eleven Rack. 

Digidesign Eleven Rack is not affiliated with, 
sponsored, or endorsed by the makers of the 
amplifiers that are emulated in this 
product. 
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When you view the Amp controls, a Page indi-
cator is displayed to show you which page of 
controls you’re viewing. Turn the Scroll wheel 
to switch pages.

Tremolo Controls

Some amps, like the ‘64 Black Panel Lux Vibrato, 
‘66 AC Hi Boost, and DC Modern Overdrive, fea-
ture authentic Tremolo circuits. Here’s what 
those controls do:

Speed Lets you set the speed of the Tremolo ef-
fect’s amplitude modulation.

Sync When set to a rhythmic value, the SYNC 
control sets the Tremolo’s speed to cycle at the 
selected rhythmic interval, in sync with the Rig 
tempo. When set to “OFF”, the speed is not syn-
chronized and can be manually set with the 
SPEED control.

Depth Sets the amount of amplitude modula-
tion. 

Amp Control page

When using Eleven Rack with Pro Tools, 
you can choose to sync tremolo and other ef-
fects to either the Rig tempo or the tempo of 
the Pro Tools session. For more details, see 
“Rig Tempo” on page 79.



Noise Gate Controls

Each of the amps in Eleven Rack has a Noise 
Gate, which can be used to suppress noise com-
ing from the instrument before the signal 
reaches the amp model. Noise can be especially 
problematic when boosted heavily at high-gain 
settings. Its controls are:

Noise Gate Lets you set the threshold of the 
Noise Gate. Adjust this control until you find a 
good balance between effective gating and cut-
ting off the signal prematurely on sustained 
notes.

Rel Sets the release time for the envelope that 
runs the Noise Gate. A longer release time can 
sound more natural, while a shorter release can 
help to rein in a really noisy signal.

Amp Output

The amp models in Eleven Rack are so faithful to 
the classics they’re based on that the output 
level can increase significantly as the preamp, 
volume or master controls are cranked. Also, 
from one amp the next, output levels will vary 
depending on their design. 

The OUTPUT control lets you compensate for 
those differences with no coloration added to 
the tone you’re getting.

Bypass

The Bypass control toggles the amp simulation 
on and off, leaving any effects in the Rig un-
changed. 

The Noise Gate remains usable even when 
the amp model has been bypassed. 

The amp output volume can also be ac-
cessed in Rig View, by selecting AMP and 
manipulating the Amp Out Vol Control 
knob.
The Speaker Cabinets
This section describes all of the emulated 
speaker cabinets available in Eleven Rack.

1x12 Black Lux

This cab model is based on the original speaker 
and cabinet that match the Lux Vibrato and Lux 
Normal amp models. With a single 12-inch ce-
ramic speaker in an open back cabinet, it offers a 
bright, warm, dynamic sound.

1x12 Tweed Lux

This cab model is based on the original speaker 
and cabinet that match the Tweed Lux amp 
model. With a single 12-inch alnico speaker in 
an open-back cabinet, it offers mellow, sweet 
warm tones with a hint of vintage grit.

2x12 AC Blue

This cab model is based on the original speakers 
and cabinet that match the AC Hi Boost amp 
model. With two British ceramic 12-inch speak-
ers in an open-back cabinet, it offers chimey, 
mid-focused tones.

2x12 Black Duo

This cab model is based on the original speakers 
and cabinet that match the Black Duo amp 
model. With two ceramic 12-inch speakers in an 
open-back cabinet, it offers bright, full-range 
tones.

The Cab page in Rig View
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4x10 Tweed Bass

This cab model is based on the original speakers 
and cabinet that match the Tweed Bass amp 
model. With four alnico 10-inch speakers in an 
open-back cabinet, it offers warm, bright, tones 
with tight bass.

4x12 Classic 30

This cab model is based on a classic 1960s 4x12 
British closed-back cabinet. The classic 30 watt 
speakers we modeled for this unit give it a wide 
frequency response and major power.

4x12 Green 25Watt

This cab model is based on a classic 1960s 4x12 
British closed-back cabinet. The vintage 25 watt 
speakers we modeled for this unit give it a 
smooth, thick tone, perfect for soulful leads.

The Microphones
This section describes all of the emulated micro-
phones available in Eleven Rack.

Dyn 7

Based on a large-diaphragm American dynamic 
microphone, the Dyn 7 model has a smooth, 
powerful tone quality.

Dyn 57

Based on a midsize-diaphragm American dy-
namic mic, the Dyn 57 model has a classic ag-
gressive tone with a bright edge and pro-
nounced mids.
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Dyn 409

Based on a midsize-diaphragm German dy-
namic mic, the Dyn 409 offers a detailed mid-
range and a focused, tight pickup pattern.

Dyn 421

Based on a large-diaphragm German dynamic 
mic, the Dyn 421 model offers deep bass, solid 
mids, and smooth treble.

Cond 67

Based on a classic German tube condenser mic, 
the Cond 67 model offers a warm, crisp sound.

Cond 87

Based on a solid-state German condenser mic, 
the Cond 87 model lacks the fuzzy tube warmth 
of Cond 67, but retains a high level of treble de-
tail and nuanced midrange.

Ribbon 121

Based on a modern ribbon microphone, the Rib-
bon 121 model offers rounded, sweet highs and 
mids, and solid, deep lows.

Digidesign Eleven Rack is not affiliated with, 
sponsored, or endorsed by the makers of the 
speaker cabinets or microphones that are em-
ulated in this product. 



The Effects
This section takes you through the effects avail-
able in Eleven Rack.

Volume Pedal

The Volume Pedal is a sweepable volume con-
trol. You can use it to fade notes or chords in 
and out, or to vary the volume of your signal in 
real time, for timbral or rhythmic effects. 

The Volume Pedal is most useful when con-
trolled with an expression pedal or MIDI foot 
controller.

For more information about using an ex-
pression pedal or MIDI foot controller, see 
“External Foot Controllers” on page 38.
Wah Effects

Black Wah

Black Wah is a standard wah pedal effect, offer-
ing a sweepable resonant filter that lets you add 
animation and special timbral effects to the gui-
tar signal.

Like the Volume Pedal, wah effects like Black 
Wah are particularly useful when controlled 
with an expression pedal or MIDI foot control-
ler.

Shine Wah

Shine Wah works and sounds similar to Black 
Wah, but with a vintage-style filter circuit and 
sweep response.
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Distortion Effects

Tri-Knob Fuzz

The pedal that inspired Tri-Knob Fuzz was a 
transistor-based unit, originally popular with 
lead guitarists searching for ever-higher gain in 
the 70s. It shone again in the 90s grunge rock 
scene, probably pushed further into woolly 
grind than its makers would have ever antici-
pated.

Volume Sets the overall output volume of the ef-
fect.

Sustain Sets the gain of the fuzz circuit.

Tone Changes the tonal balance of the effect, 
from deep and full of sub-bass to high and shrill.

BlackOp Distortion

Inspired by an 80s-era op-amp-based distortion 
pedal, BlackOp Distortion offers massive crunch 
and power. Its hard-clipping drive can squeeze 
aggressive rhythm and lead tones out of soft-
sounding vintage amps, and create surprisingly 
hard-edged tones when paired with more mod-
ern amps.
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Green JRC Overdrive

Green JRC Overdrive was inspired by a low-gain 
70s overdrive pedal, loved by blues and blues-
rock players the world over for its sweet, singing 
sting. It can be used to simply drive an amp’s in-
put section into gentle clipping, or supply some 
dirty glow of its own.

Modulation Effects

Flanger

Originating from the act of pressing on the 
flanges of tape reels, and becoming even more 
popular with the advent of analog pedals, the 
Flanger effect can be coaxed into bell-like reso-
nant sweeps, or add a silky, shimmering sheen. 
This effect works well when positioned before or 
after the amplifier in the signal chain.

Pre-Dl Sets the amount of pre-delay, which 
changes the phase relationship between the dry 
signal and the delayed signal, with timbral re-
sults.



Depth Sets the amount of delay. The higher the 
setting, the more “jet-engine” artifacts will be 
introduced.

Fdback Sets the amount of signal fed back into 
the modulated delay. Higher settings introduce 
more ringing, whistling artifacts.

C1 Chorus/Vibrato

Based on a heavyweight late-70s analog cho-
rus/vibrato pedal, CI Chorus/Vibrato offers 
warm, liquid modulation effects. In Chorus 
mode, the signal is routed through a modulated 
short delay, which is mixed with the dry signal, 
creating a washy, doubled sound. 

In Vibrato mode, the dry signal is absent and 
there is more control over the depth of pitch 
modulation, allowing for everything from an 
understated “wobble” to wacky, synth-like pitch 
modulation.

Chorus Sets the intensity and speed of the Cho-
rus effect, only when the Chorus/Vibrato switch 
is set to Chorus.

Depth Sets the depth of the Vibrato effect, only 
when the Chorus/Vibrato switch is set to Vi-
brato.

Rate Controls the Vibrato rate, only when the 
Chorus/Vibrato switch is set to on.
Chorus/Vibrato Toggles the effect between Cho-
rus and Vibrato. 

U Phaser

The psychedelic-era phaser that inspired our 
U Phaser effect was traditionally paired with an 
expression pedal that could be used to vary the 
rate of pitch modulation over time. Like the C1, 
you can choose to run it as a Chorus, with the 
modulated and dry signals mixed together, or in 
Vibrato mode, which leaves the pitch-modu-
lated signal alone, with rippling, disorienting ef-
fects.

Chorus/Vibrato Toggles the dry signal on (Cho-
rus) and off (Vibrato).

When set to CHORUS, the Rate and Depth 
controls are inactive. Likewise, when set to 
VIBRATO, the Chorus control will not 
function.
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Orange Phaser

Based on a more basic analog phaser, 
Orange Phaser offers a more subtle, warm phas-
ing effect.

Speed Controls the Phaser effect’s rate of modu-
lation.

Sync Synchronizes the modulation rate to the 
Rig tempo by a specific rhythmic subdivision.

Roto Speaker

Inspired by the rotating speaker cabinets that 
made classic tonewheel organs roar, Roto 
Speaker offers added motion and vintage grit.

Speed Sets the speed of the rotating speaker ef-
fect, in three increments, Slow, Fast, and Brake 
(stopped).

Balance Sets the blend between the upper and 
lower rotors of the rotating speaker.

Type Chooses between various types of rotary 
speakers.
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Reverb Effects

Blackpanel Spring Reverb

Blackpanel Spring Reverb was inspired by a clas-
sic outboard tube-driven spring reverb. It can 
add a surfy twang and dark, warm ambience to 
your signal. 

Mix Controls the blend between dry and rever-
bed signal.

Decay Controls the length of the reverb’s decay.

Tone Applies a high-cut EQ, making the reverb 
tone darker.

Eleven SR

A smooth, clean digital reverb, Eleven SR is 
based on the popular Reverb One Pro Tools 
plug-in from Digidesign.

Pre-Dly Sets the amount of pre-delay, which 
changes the time relationship between the dry 
signal and the reverbed signal. As this setting is 
turned higher, the apparent size of the synthe-
sized reverb “room” grows larger.

Type Selects from a variety of different reverb 
types.



Delay Effects

Tape Echo

Inspired by the ultimate vintage solid state tape 
echo unit, Tape Echo supplies supple, crunchy 
echoes, and can, with a flick of the wrist, can be 
pushed into swells of wild self-oscillation, each 
repeat more murky, dusty, and gritty than the 
next. A classic.

Rec Lev Controls the signal level running to the 
tape circuitry. Higher settings create a more dis-
torted tone color.

Head Simulates the alignment (or misalign-
ment) of the tape head with the tape, which af-
fects the tone of the delay. 

Wow Controls the amount of wow and flutter in 
the tape mechanism. Lower settings minimize 
fluctuations of pitch and tone color, and higher 
settings accentuate it.

Hiss For some serious authenticity in your tape 
echo tone, this switch Toggles modeled analog 
tape hiss in or out of the signal. With high feed-
back settings, the tape hiss can push the echo 
into self-oscillating mayhem.
BBD Delay

When “bucket brigade” analog delays arrived in 
the mid-70s, their relatively small size and solid-
state reliability made them a godsend to tape 
loop-addled guitarists. It went on to become a 
classic of its own, with a smooth, round delay 
sound and a Chorus-Vibrato mode that let it 
double as a modulation effect. 

Input Sets the input level to the delay effect. 
Cranked up, it can push the signal into useful 
distortion.

Mod Switches the modulation effect between Vi-
brato (only the delayed signal is passed) and 
Chorus (both the dry and delayed signal are 
passed.)

Depth Controls the level of modulation of the 
delayed signal.

Noise Toggles modeled analog hiss in or out of 
the signal.

When Hiss or Noise is turned on in one of 
the delay effects and the feedback level is 
sufficiently high, the delay will self-oscil-
late and make noise, even when bypassed. 
If this occurs, turn down the feedback con-
trol.
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EQ & Compressor Effects

Graphic EQ

Useful for simple frequency sculpting, a good 
Graphic EQ can find a place in almost any ped-
alboard. Graphic EQ can wring a variety of tones 
out of other pedals, such as when placed before 
Distortion effects. The EQ can also be used as a 
signal booster when positioned in front of amps.

Gray Comp

Inspired by a well-loved solid-state 70s compres-
sor pedal, Gray Comp can add singing sustain to 
leads or lend power and girth to chunky rhythm 
guitar parts.

Sustain Sets the threshold, and thus, the 
amount of compression, in the Compressor ef-
fect.

Level Sets the overall output volume of the ef-
fect.

Digidesign Eleven Rack is not affiliated 
with, sponsored, or endorsed by the makers 
of the effects that are emulated by this prod-
uct.
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General Effects Controls

Sync

The time-based effects in Eleven Rack (such as 
Chorus, Delay and Flanger) can be set to syn-
chronize with Rig or Session tempo. When the 
Sync control on these effects is set to a rhythmic 
subdivision of the incoming tempo, the effect 
will lock to it. When Sync is set to Off, the Rate 
or Delay control on the effect will take over, and 
the rate of modulation or delay can be set by 
hand.

Delay+ & Fine

These two controls are included in both delay ef-
fects. Delay+ quadruples the available delay 
time, for when longer echoes are needed. Fine 
switches the delay’s Rate control into a fine-ad-
just mode, where the delay time can be set by 
the millisecond with the Scroll wheel. Press Fine 
again to return to normal mode.

Don’t Forget to Save!
Remember, when you’ve got things tweaked just 
right, make sure to save your settings. If you 
switch to a different Rig before saving, you’ll 
lose your changes. To simply save the current 
state of the Rig you’re working on to the same 
Rig memory location, press the Save button, 
then press it again.

See “Saving Your Work” on page 19 for 
more details.



Chapter 4: Eleven Rack Live Setup

In live performance or practice, Eleven Rack can be used as a standalone guitar preamp and processor, 
connected to an amplifier and/or direct to a PA system. This chapter will describe how to make the 
necessary connections.
Figure 4.  Eleven Rack Live Setup

MIDI Foot Controller
Footswitch or 

Expression PedalEffects

PA Mixer
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Basic Live Setup
Eleven Rack User Guide
Figure 5.  Eleven Rack connected directly to the PA mixer

PA Mixer
Plugging in Your Guitar

Connect your guitar to the Guitar input on the 
front of Eleven Rack with a 1/4” TS cable.
Connecting Eleven Rack to a PA 
System

The simplest way to play live with Eleven Rack is 
to connect it directly to the PA mixer using the 
Main XLR outputs. When doing so, it is recom-
mended to tell the person running the PA sys-
tem that you are providing a line-level signal, 
rather than a mic-level signal, so that they can 
correctly set the input on the console.

If a buzz or hum occurs, try toggling the Gnd 
Lift switch.



Using an Amp Onstage
Figure 6.  Eleven Rack connected to the PA mixer and an onstage amplifier

PA Mixer
In some cases, having an amplifier onstage can 
be handy for monitoring or tone reasons. Eleven 
Rack makes it easy to feed your signal to both a 
PA mixer and an amp.

Connecting Eleven Rack to a 
Guitar Amplifier

The Output To Amp outputs on Eleven Rack can 
be connected to one or more guitar amplifiers 
using standard 1/4” TS cables. 

• If using a single, mono amplifier, use the Out-
put To Amp 1 (L) output. 

• If using two amplifiers, or an amp with stereo 
inputs, connect each Output To Amp output 
to a separate amp or channel input.
Sending the Correct Signal

Eleven Rack lets you choose the point in the sig-
nal path that feeds each Output To Amp jack. If 
you’re using an amplifier with a distinct tone of 
its own, you may want to send it a signal with 
little processing (for example, only the effects) 
so the sound of the amp can ring through 
clearly. 

If you prefer to use the amp simulations in 
Eleven Rack to set your tone, you will want to 
send the signal just after the amp simulation, 
but before the cabinet simulation, to your am-
plifier.
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To set the type of signal to send to the amp:

1  Press and hold the Edit/Back button to show 
the User Options mode.

2  Scroll to Outputs To Amp with the Scroll wheel.

3  Press SW1 to enter the Outputs To Amp 
screen.

4  Choose the output you plan to use to feed the 
amp, with the Scroll wheel.

5  Set the Signal control to one of the following, 
using the first lit Control knob:

• Rig Input (no processing)

• Amp Input (pre-amp effects only)

• Amp Output (effects and amp simulation)

6  Press Edit/Back twice to leave User Options 
mode.

The signal level running to each Output To 
Amp output can be set on a per-rig basis in 
the Output section in Rig View or in the 
Eleven Rack Control window. For more de-
tails, see “OUTPUT” on page 17, or “Out-
put to Amp Selectors” on page 80.

Because Eleven Rack simulates various pre-
amps and tone circuits, you may want to by-
pass your amp’s preamp and tone circuitry 
by plugging into the amplifier’s effects re-
turn jack(s), if available, rather than the 
standard input(s). If your amp does not 
have an effects loop, try setting the amp 
controls for maximum transparency (EQ 
flat, gain stages set to clean.)
Eleven Rack User Guide



Effects and Foot Controllers
Figure 7.  Effects and foot controller connections
Connecting Effects

Use the FX loop jacks to connect stomp boxes, 
rack effects or other external processors to the 
live guitar signal. These can be either rack or 
stompbox effects, or a combination thereof, in 
mono or stereo. The FX Loop accepts 1/4” plugs.

To connect external effects to Eleven Rack:

1  Connect the FX Loop Send output on Eleven 
Rack to the input of your first (or only) effects 
unit. If the unit is mono, use the Left/Mono out-
put. If the unit is stereo, use both outputs.

2  Connect the output of the final (or only) ef-
fects unit to the FX Loop Return input on Eleven 
Rack. If the unit is mono, use the Left/Mono in-
put. If the unit is stereo, use both inputs.

If using a combination of mono and stereo 
effects, it is usually best to put the mono ef-
fects units first in the chain, with the final 
mono unit connected to the mono input on 
the first stereo unit.
3  If using a line-level rack effect, toggle the Rack 
FX/Stompbox FX switch to the Rack FX posi-
tion. If using a guitar-level stompbox effect, tog-
gle the switch to the Stompbox FX position.

External Foot Controllers
Eleven Rack has a 1/4” TRS input that can accept 
input from an expression pedal or a single or 
dual momentary footswitch. 

If using a combination of guitar-level 
(stompbox) and line-level (rack) effects, it 
may be preferable to put the guitar-level 
unit(s) first in the chain. If your line-level 
unit(s) have guitar-level outputs available, 
the order is not important. See your effects 
unit(s) documentation for more details.

The User Options and Rig View modes in 
Eleven Rack contain a variety of settings 
that control the behavior of the FX loop. For 
more information, see “The Amps” on 
page 20 and “FX Loop” on page 93.
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Expression Pedal

An expression pedal can be used to control con-
tinuously variable parameters within Eleven 
Rack, such as volume or wah position.

In addition to commonly-used expression ped-
als, a standard volume pedal with a “Y” adapter 
cable (two 1/4-inch TS plugs to one 1/4-inch TRS 
plug) can be used, though keep in mind that the 
taper of the potentiometer in a volume pedal is 
exponential, rather than linear as in an expres-
sion pedal.

Momentary Footswitch 
(Single or Dual)

Most single or dual momentary footswitches 
can be used to toggle various switched functions 
within Eleven Rack, such as effects on/off and 
cycling through rigs.

Choose a momentary footswitch with a 
1/4-inch TS (single switch) or 1/4-inch TRS (dual 
switch) connection.

For more information on the use of pedals 
and footswitches with Eleven Rack, “Exter-
nal Pedals” on page 93.
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MIDI Foot Controller

You can connect a MIDI foot controller to the 
MIDI input on Eleven Rack, providing control 
over a larger range of simultaneous parameters.

Display Mode and Visibility
When playing live, you may find it easier to 
keep track of what Rig is selected by switching 
the display to Simple mode.

For details on Eleven Rack controls you can 
control with a MIDI foot controller, see 
“Eleven Rack MIDI CC Controllers” on 
page 95.

For information on switching display 
modes, “Rig Select Mode” on page 13.
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Chapter 5: Installing Pro Tools on Mac
This chapter contains information for Mac sys-
tems only. If you are installing Pro Tools on a 
Windows computer, see Chapter 6, “Installing 
Pro Tools On Windows.”

If you’re installing or upgrading Pro Tools HD to 
work with Eleven Rack, please refer to the Setup 
Guide for your system.

Installation Overview
Installation of the Eleven Rack on a Mac in-
cludes the following steps:

1  “Installing Pro Tools LE and Connecting 
Eleven Rack” on page 41.

2  “Launching Pro Tools LE” on page 43.

3  Configuring your system for improved perfor-
mance (see Chapter 7, “Pro Tools Configura-
tion”).

4  Making audio connections to the Eleven Rack 
(see Chapter 8, “Eleven Rack Studio Setup”).

Before installing this version of Pro Tools, 
refer to the Read Me information included 
on the Pro Tools Installer disc.

The Pro Tools Installer disc includes addi-
tional software for your system. For more in-
formation, see “Additional Software on the 
Pro Tools Installer Disc” on page 43.
Installing Pro Tools LE and 
Connecting Eleven Rack
Before connecting your Eleven Rack to the com-
puter, you need to install Pro Tools LE software.

To install Pro Tools LE on Mac OS X:

1  Make sure you are logged in as an Administra-
tor for the account where you want to install 
Pro Tools.

2  Insert the Pro Tools LE Installer disc in your 
DVD drive. 

3  On the Installer disc, locate and double-click 
Install Pro Tools LE.mpkg.

Do not start this procedure with your Eleven 
Rack connected to your computer.

For details on Administrator privileges in 
Mac OS X, see your Apple OS X documen-
tation. 

Install Pro Tools LE.mpkg icon
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4  Follow the on-screen instructions to proceed 
with installation.

5  Click Continue each time you are prompted.

6  At the Installation Type page, do one of the 
following:

• To install all Pro Tools application files and 
free plug-in suites (and associated content), 
leave the default Installation options se-
lected and click Continue.

– or –

• Select (or deselect) a custom configuration 
of Installation options (see “Installation 
Options” on page 42) and click Continue.

7  Click Install. 

8  If prompted, enter your Administrator pass-
word and click OK to authenticate the installa-
tion. 

9  Follow the remaining on-screen instructions. 

10  When installation is complete, click Restart.

11  After the computer has started, connect the 
small end of the included USB cable to the USB 
port on Eleven Rack and connect the other end 
to any available USB port on your computer.

Eleven Rack may not function properly if 
connected to a USB hub. If you need to use a 
hub for other USB peripherals, connect the 
hub to a separate USB port; Eleven Rack 
must be connected to a dedicated port on 
the computer in order to function properly.
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Installation Options

Pro Tools LE Options

To install a subset of Pro Tools software and 
plug-ins (and associated content), click the re-
veal triangle for the Pro Tools LE option in the 
installer, and deselect any of the following op-
tions that you do not want installed.

Application Files (Required for Pro Tools) Installs 
the Pro Tools application and supporting library 
files needed to run Pro Tools. This option also 
installs the Digidesign CoreAudio Driver. This 
option must be selected to install Pro Tools.

DigiRack Plug-Ins Installs free plug-ins including 
DigiRack plug-ins, free Bomb Factory plug-ins, 
TL Utilities, and Digidesign D-Fi and Maxim 
plug-ins.

Pro Tools Creative Collection Installs a set of free 
RTAS effects plug-ins and virtual instrument 
plug-ins (including over 4 GB of associated sam-
ple content). For more information, see the Cre-
ative Collection Plug-ins Guide.

Additional Options

The Pro Tools installer provides the following 
additional options to install along with 
Pro Tools software and plug-ins.

Digidesign CoreAudio Driver This option installs 
the Digidesign CoreAudio Driver, which lets you 
use qualified audio interfaces with third-party 
applications that support the CoreAudio Driver 
standard. 

Avid Video Engine This option lets you integrate 
Avid® video peripherals (such as the Avid Mojo® 
with your Pro Tools system).

MIDI I/O Driver The MIDI I/O™ Driver is re-
quired if you are using the Digidesign MIDI I/O 
interface. 



Launching Pro Tools LE
When launching Pro Tools LE the first time, you 
are prompted to enter an authorization code to 
validate your software. The code begins with the 
letters “DIGI”.

To authorize Pro Tools LE software:

1  Make sure Eleven Rack is connected to your 
computer.

2  Click the Pro Tools LE icon in the Dock (or 
double-click the application icon in the 
Pro Tools folder inside the Digidesign folder). 

3  Enter the authorization code in the dialog 
(making sure to type it exactly as printed, and 
observing any spaces and capitalization), then 
click Validate. (Your authorization code is lo-
cated on a sticker on the Pro Tools LE DVD wal-
let.) 

4  Use the Quick Start dialog to do one of 
the following:

• Create a new session from template.

• Create a new blank session.

• Open any other session on your system.

Quick Start dialog

For more information on the Quick 
Start dialog and session templates, see the 
Pro Tools Reference Guide (Help > 
Pro Tools Reference Guide).
Additional Software on the 
Pro Tools Installer Disc
The Pro Tools LE Installer disc provides addi-
tional software for your system, including audio 
drivers (for playing other audio applications 
through your Digidesign hardware) and a 
Pro Tools demo session.

Third-Party Applications and 
Plug-ins

Your Pro Tools package also includes several free 
applications and plug-ins from selected Digide-
sign Third Party developers. Once you've com-
pleted your Pro Tools installation, you can in-
stall these separately. Go to the Additional 
Files/3rd Party Content folder on the 
Pro Tools LE Installer disc.

Eleven Rack CoreAudio Driver

The Eleven Rack CoreAudio Driver is a multi-cli-
ent, multichannel sound driver that allows 
CoreAudio compatible applications to record 
and play back through Digidesign hardware. 

The Eleven Rack CoreAudio Driver is installed 
by default when you install Pro Tools.

Check your Pro Tools Installer disc for addi-
tional software and installers.

For information on configuring the 
Eleven Rack CoreAudio Driver, see the Core-
Audio Drivers Guide. 
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Standalone Eleven Rack CoreAudio Driver

The Eleven Rack CoreAudio Driver can be in-
stalled as a standalone driver on Mac systems 
that do not have Pro Tools software installed. 
The standalone version of this driver is available 
on the Pro Tools Installer disc (in the Additional 
Files Folder).
.

Pro Tools Demo Session

The Pro Tools LE Installer disc includes a demo 
session that you can use to verify that your sys-
tem is working.

The demo session for Pro Tools LE is named “Fil-
tered Dream.”

To install the demo session:

1  Insert the Pro Tools LE Installer disc into your 
DVD drive.

2  On the Pro Tools LE Installer disc, locate and 
open the Additional Files/Pro Tools Demo Ses-
sions Installer folder.

3  Double-click Install demo session.pkg.

4  Follow the on-screen instructions.

5  When prompted, select your audio drive as 
the install location and click Next to begin the 
installation. When installation is complete, 
click Close.

For information on installing and configur-
ing the standalone version of the Eleven 
Rack CoreAudio Driver, see the CoreAudio 
Drivers Guide.

Before installing the demo session to your 
audio drive, make sure the drive is config-
ured as described in “Formatting an Audio 
Drive” on page 100.
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Uninstalling Pro Tools
If you need to uninstall Pro Tools software from 
your computer, use the Uninstaller application. 

To remove Pro Tools from your computer:

1  Make sure you are logged in as an Administra-
tor for the account where Pro Tools is installed. 

2  Go to Applications/Digidesign/Pro Tools/
Pro Tools Utilities and double-click 
Uninstall Pro Tools.

3  Click Continue to proceed with the uninstall.

4  Choose the type of uninstall you want to per-
form:

Safe Uninstall Leaves certain plug-ins and sys-
tem files needed for compatibility with some 
Avid products. Use Safe Uninstall if you are us-
ing an Avid application or preparing to update 
to a CS (customer support) release.

Clean Uninstall Removes all Pro Tools files, in-
cluding system files, Digidesign plug-ins, and 
MIDI patch names. Use Clean Uninstall when-
ever you are preparing to upgrade, or to trouble-
shoot from a clean system.

5  Click Uninstall. 

6  Enter your Administrator password and click 
OK. 

7  Click Finish to close the Installer window.

The demo session can be opened by double-
clicking the Filtered Dream.ptf file (located 
in the Filtered Dream Demo Session folder).

For details on Administrator privileges in 
Mac OS X, see your Apple OS X documen-
tation. 



Chapter 6: Installing Pro Tools On 
Windows
This chapter contains information for Windows 
systems only. If you are installing Pro Tools on a 
Mac computer, see Chapter 5, “Installing 
Pro Tools on Mac.”

If you’re installing or upgrading Pro Tools HD to 
work with Eleven Rack, please refer to the Setup 
Guide for your system.

Installation Overview
Installing the Eleven Rack on a Windows com-
puter includes the following steps:

1  “Installing Pro Tools LE and Connecting Your 
Interface” on page 46.

2  “Launching Pro Tools LE” on page 48.

3  Configuring your system for improved perfor-
mance (see Chapter 7, “Pro Tools Configura-
tion”).

Before installing this version of Pro Tools, 
refer to the Read Me information included 
on the Pro Tools LE Installer disc.
4  Making audio and MIDI connections to the 
Eleven Rack (see Chapter 8, “Eleven Rack Studio 
Setup” for details).

The Pro Tools Installer disc includes addi-
tional software for your system. For more in-
formation, see “Additional Software on the 
Pro Tools Installer Disc” on page 48.
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Installing Pro Tools LE and 
Connecting Your Interface
Before connecting your Pro Tools LE interface to 
the computer, you need to install Pro Tools LE 
software.

To install Pro Tools LE: 

1  Start Windows, logging in with Administrator 
privileges. For details on Administrator privi-
leges, refer to your Windows documentation.

2  Insert the Pro Tools LE Installer disc in your 
DVD drive and do one of the following:

• If Windows AutoRun is enabled, the in-
staller splash screen will appear. Follow the 
on-screen instructions.

– or –

• If Windows AutoRun is disabled and the 
splash screen does not appear, locate and 
double-click Setup.exe on the installer disc.

 

Do not start this procedure with your Eleven 
Rack connected to your computer.

Setup.exe icon

In Vista, if the User Account Control dialog 
appears, click Allow.
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3  Follow the on-screen instructions to proceed 
with installation and click Next when prompted.

4  To install the complete compliment of 
Pro Tools software and plug-ins, leave Pro Tools 
selected. 

5  At the Select Features page, do one of the fol-
lowing:

• To install all Pro Tools application files and 
free plug-in suites (and associated content), 
leave the default Installation options se-
lected and click Continue.

– or –

• Select (or deselect) a custom configuration 
of Installation options (see “Installation 
Options” on page 47) and click Continue.

6  Click Next.

7  Click Install.

8  When prompted, connect the small end of the 
included USB cable to the USB port on Eleven 
Rack.Connect the other end of the USB cable to 
any available USB port on your computer.

9  Click OK.
 

Eleven Rack may not function properly if 
connected to a USB hub. If you need to use a 
hub for other USB peripherals, connect the 
hub to a separate USB port; Eleven Rack 
must be connected to a dedicated port on the 
computer in order to function properly

In Windows Vista, a series of Windows Se-
curity dialogs may appear. Click “Install” on 
each one until they go away.



 

10  Wait for the installer to finish installing all 
software components, drivers, and PACE System 
files before proceeding to the next step. 

11  When installation is complete, click Finish 
and restart your computer.

Installation Options

Pro Tools LE Options

To install a subset of Pro Tools software and 
plug-ins (and associated content), click the plus 
(+) next to Pro Tools LE option in the Select Fea-
tures page of the installer, and deselect any of 
the following options that you do not want in-
stalled.

Application Files (Required for Pro Tools) Installs 
the Pro Tools application and supporting library 
files needed to run Pro Tools. This option must 
be selected to install Pro Tools.

DigiRack Plug-Ins Installs free plug-ins including 
DigiRack plug-ins, free Bomb Factory plug-ins, 
TL Utilities, and Digidesign D-Fi and Maxim 
plug-ins.

Pro Tools Creative Collection Installs a set of free 
RTAS effects plug-ins and virtual instrument 
plug-ins (including over 4 GB of associated sam-
ple content). For more information, see the Cre-
ative Collection Plug-ins Guide.

In Windows XP, a series of Software Instal-
lation dialogs about the driver not passing 
Windows Logo testing may appear. Click 
Continue Anyway on each one until they go 
away.

If any other dialogs appear (such as the 
“Found New Hardware” dialog), leave them 
open and do not click on them. These dia-
logs will close on their own.
Additional Options

The Pro Tools installer provides the following 
additional options to install along with 
Pro Tools software and plug-ins.

Mac HFS+ Disk Support Option This option lets 
your Pro Tools system read, write, record, and 
play back using Mac-formatted HFS+ disks. HFS+ 
disks are commonly referred to as Mac OS Ex-
tended disks.

Avid Video Engine The Avid Video Engine is re-
quired to use Pro Tools with Avid video periph-
erals such as the Avid Mojo. 

Command|8 Controller and Driver The Com-
mand|8® driver is required if you are using the 
Digidesign Command|8 control surface.

Installing QuickTime

QuickTime is required for Pro Tools if you plan 
to include movie files, or import MP3 or MP4 
(AAC) files in your sessions. QuickTime for Win-
dows is available as a free download from the 
Apple website (www.apple.com).

To install QuickTime:

1  Visit www.apple.com and go to the Quick-
Time page.

2  Download the QuickTime installer applica-
tion to your computer.

3  Double-click the QuickTime installer applica-
tion and follow the on-screen installation in-
structions.

4  Restart your computer.

For information on which version of Quick-
Time is compatible with your version of 
Pro Tools, visit the compatibility pages of 
the Digidesign website: 
www.digidesign.com/compatibility
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Launching Pro Tools LE
When launching Pro Tools LE the first time, you 
are prompted to enter an authorization code.

To authorize Pro Tools LE software:

1  Make sure Eleven Rack is connected to your 
computer.

2  Double-click the Pro Tools LE shortcut on 
your desktop (or the application icon in the 
Pro Tools folder inside the Digidesign folder).

3  Enter the authorization code in the dialog 
(making sure to type it exactly as printed, and 
observing any spaces and capitalization), then 
click Validate. (Your authorization code is lo-
cated on a sticker on the Pro Tools LE DVD wal-
let.) 

4  Use the Quick Start dialog to do one of 
the following:

• Create a new session from template.

• Create a new blank session.

• Open any other session on your system.

Quick Start dialog

For more information on the Quick 
Start dialog and session templates, see the 
Pro Tools Reference Guide (Help > 
Pro Tools Reference Guide).
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Additional Software on the 
Pro Tools Installer Disc
The Pro Tools LE Installer disc provides addi-
tional software for your system, including audio 
drivers (for playing other audio applications 
through your Digidesign hardware) and a 
Pro Tools demo session.

Third-Party Applications and 
Plug-ins

Your Pro Tools package also includes several free 
applications and plug-ins from selected Digide-
sign Third Party developers. Once you've com-
pleted your Pro Tools installation, you can in-
stall these separately. Go to the Additional 
Files\3rd Party Content folder on the 
Pro Tools LE Installer disc.

Windows Audio Drivers

The Digidesign ASIO Driver and WaveDriver 
Windows System Audio Driver let you use your 
Digidesign Eleven Rack hardware interface with 
third-party applications that support the ASIO 
Driver or WaveDriver MME (Multimedia Exten-
sion).

The Digidesign ASIO Driver and WaveDriver for 
Eleven Rack are automatically installed when 
you install Pro Tools.

Refer to your Pro Tools Installer disc for ad-
ditional software and installers.



Digidesign ASIO Driver

The Digidesign ASIO (Audio Sound Input Out-
put) Driver is a single-client multichannel 
sound driver that allows third-party audio pro-
grams that support the ASIO standard to record 
and play back through Digidesign hardware.

Digidesign WaveDriver

(Windows XP Only)

The Digidesign WaveDriver Windows System 
Audio Driver is a single-client, stereo sound 
driver that allows third-party audio programs 
that support the WaveDriver MME (Multimedia 
Extension) standard to play back through 
Digidesign hardware.

Standalone Windows Audio Drivers

Digidesign Windows Audio Drivers can be in-
stalled on Windows systems that do not have 
Pro Tools software installed. Use the standalone 
version of the Digidesign Windows Audio Driv-
ers installer (Digidesign Audio Drivers 
Setup.exe), which is available on the 
Pro Tools LE Installer disc.

For detailed information on configuring the 
Digidesign ASIO Driver, see the Windows 
Audio Drivers Guide.

For detailed information on configuring the 
Digidesign WaveDriver, see the Windows 
Audio Drivers Guide.

For information on installing and configur-
ing the standalone version of the Digidesign 
Windows Audio Drivers, see the Windows 
Audio Drivers Guide.
Pro Tools Demo Session

The Pro Tools LE Installer disc includes a demo 
session that you can use to verify that your sys-
tem is working.

The demo session for Pro Tool LE is named “Fil-
tered Dream.”

To install the demo session:

1  Insert the Pro Tools LE Installer disc into your 
DVD drive.

2  On the Pro Tools LE Installer disc, locate and 
open the Additional Files\Pro Tools Demo Ses-
sions Installer folder.

3  Double-click LE Demo Session Setup.exe.

4  Follow the onscreen instructions.

5  When prompted, select your audio drive as 
the install location and click Next to begin the 
install.

6  When installation is complete, click Finish.

Before installing the demo session to your 
audio drive, make sure the drive is config-
ured as described in “Formatting an Audio 
Drive” on page 100.

The demo session can be opened by double-
clicking the Filtered Dream.ptf file (located 
in the Filtered Dream Demo Session folder).
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Uninstalling Pro Tools
Use the Uninstall Pro Tools application to unin-
stall Pro Tools software from your computer.

To uninstall Pro Tools from your computer:

1  Start Windows, logging in with Administrator 
privileges. For details on Administrator privi-
leges, refer to your Windows documentation.

2  Go to C:\Program Files\Digidesign\ 
Pro Tools\Pro Tools Utilities and double-click 
Uninstall Pro Tools.exe.

3  Click Next.

4  Click Uninstall to proceed with the uninstalla-
tion.
Eleven Rack User Guide



Chapter 7: Pro Tools Configuration
After you have connected your system and in-
stalled Pro Tools software, you are ready to start 
up and configure your Pro Tools system.

Starting Up or Shutting Down 
Your System
To ensure that the components of your 
Pro Tools system communicate properly with 
each other, you need to start them in a particu-
lar order.

Start up your Pro Tools system in this order:

1  Lower the volume of all output devices in your 
system. 

2  Turn on your Eleven Rack.

3  Turn on any external hard drives. Wait ap-
proximately ten seconds for them to spin up to 
speed.

4  Turn on any control surfaces (such as Com-
mand|8).

5  Turn on any MIDI interfaces, MIDI devices, or 
synchronization peripherals.

6  Turn on your computer. 

7  Launch Pro Tools or any third-party audio or 
MIDI applications. 
Shut down your Pro Tools system in this order:

1  Quit Pro Tools and any other running applica-
tions. 

2  Turn off or lower the volume of all output de-
vices in your system. 

3  Turn off your computer.

4  Turn off any MIDI interfaces, MIDI devices, or 
synchronization peripherals.

5  Turn off any control surfaces.

6  Turn off any external hard drives.

7  Turn off your Eleven Rack.

To quit Pro Tools, choose Pro Tools > Quit 
(Mac) or File > Exit (Windows).
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Configuring Pro Tools LE

Pro Tools System Settings

In the Playback Engine dialog, Pro Tools LE lets 
you adjust the performance of your system by 
changing system settings that affect its capacity 
for processing, playback, and recording. 

In most cases, the default settings for your sys-
tem provide optimum performance, but you 
may want to adjust them to accommodate large 
or processing-intensive Pro Tools sessions. 

Playback Engine dialog (Structure plug-in installed)
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Hardware Buffer Size

The Hardware Buffer Size (H/W Buffer Size) con-
trols the size of the buffer used to handle host 
processing tasks such as RTAS plug-ins. 

• Lower Hardware Buffer Size settings are useful 
for improving latency issues in certain record-
ing situations or for improving certain system 
performance problems. On Pro Tools LE sys-
tems, lower settings reduce all input-to-out-
put monitoring latency on any record-armed 
tracks or Auxiliary Input tracks with live in-
puts.

• Higher Hardware Buffer Size settings are use-
ful for sessions that are using more RTAS plug-
ins for playback. These settings allow for more 
audio processing. They can also be useful to 
reduce errors on machines that require a 
higher buffer size.

To change the Hardware Buffer Size:

1  Choose Setup > Playback Engine.

2  From the H/W Buffer Size pop-up menu, select 
the audio buffer size, in samples.

3  Click OK.

In addition to causing slower screen re-
sponse and monitoring latency, higher 
Hardware Buffer Size settings can increase 
the latency caused by RTAS plug-ins, and 
affect the accuracy of plug-in automation, 
mute data, and MIDI track timing.

Low Latency Monitoring mode can be used 
to circumvent latency caused by higher buf-
fer settings when recording. This can be tog-
gled on and off by clicking Options > Low 
Latency Monitoring in Pro Tools.



RTAS Processors

The RTAS Processors setting determines the 
number of processors in your computer allo-
cated for RTAS (Real-Time AudioSuite) plug-in 
processing.

With computers that have multiple processors, 
or that feature multi-core processing or hyper-
threading, this setting lets you enable multipro-
cessor support for RTAS plug-ins. Used in combi-
nation with the CPU Usage Limit setting, the 
RTAS Processors setting lets you control the way 
RTAS processing and other Pro Tools tasks are 
handled by the system. 

For example: 

• For sessions with large numbers of RTAS plug-
ins, you can allocate 2 or more processors to 
RTAS processing and set a high CPU Usage 
Limit.

• For sessions with few RTAS plug-ins, you can 
allocate fewer processors to RTAS processing 
and set a low CPU Usage Limit to leave more 
CPU resources available for automation accu-
racy, screen response, and video. 

• Depending on the importance of video and 
overall screen response, and on the density of 
automation being employed, try different 
combinations of RTAS Processors and CPU Us-
age Limit settings to achieve the best results. 
For example, to improve screen response in a 
medium-sized session using a moderate num-
ber of RTAS plug-ins, try reducing the number 
of RTAS plug-ins, but keep the CPU Usage Limit 
set to the maximum (up to 99% on a single 
processor system).
To set the number of RTAS Processors:

1  Choose Setup > Playback Engine. 

2  From the RTAS Processing pop-up menu, select 
the number of available processors you want to 
allocate. The number of processors available var-
ies depending on how many processors are 
available on your computer:

• Select 1 Processor to limit RTAS processing 
to one CPU in the system. 

• Choose 2 Processors to enable load balanc-
ing across two available processors.

• On systems running four or more proces-
sors, choose the number of processors for 
RTAS processing.

3  Click OK.

System Usage Window and RTAS Processing

The System Usage window (Window > System Us-
age) displays the combined amount of RTAS 
processing occurring on all enabled processors 
with a single indicator, regardless of how many 
processors are available in the system. If the Sys-
tem Usage Window shows that you are at the 
limit of available resources, increase the number 
of RTAS processors and adjust the CPU Usage 
Limit setting.
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CPU Usage Limit

The CPU Usage Limit setting controls the per-
centage of CPU resources allocated to Pro Tools 
host processing tasks. Used in combination with 
the RTAS Processors setting, the CPU Usage Limit 
setting lets you control the way Pro Tools tasks 
are carried out by the system.

• Lower CPU Usage Limit settings limit the effect 
of Pro Tools processing on other CPU-inten-
sive tasks, such as screen redraws, and are use-
ful when you are experiencing slow system 
response, or when running other applications 
at the same time as Pro Tools.

• Higher CPU Usage Limit settings allocate more 
processing power to Pro Tools, and are useful 
for playing back large sessions or using more 
RTAS plug-ins. 

The maximum available CPU Usage Limit de-
pends on the number of processors in your com-
puter and on the number of processors you spec-
ify for RTAS processing. This value can range 
from 85% for single-processor computers, and 
99% for multiprocessor computers (which dedi-
cate one entire processor to Pro Tools).

On multiprocessor computers, the maximum 
CPU Usage Limit is reduced when you use all your 
processors (as selected in the RTAS Processing 
pop-up menu). For example, on dual-processors, 
the limit is 90%. On four-processor computers, 
the limit is 95%.

To change the CPU Usage Limit:

1  Choose Setup > Playback Engine. 

2  From the CPU Usage Limit pop-up menu, select 
the percentage of CPU processing you want to 
allocate to Pro Tools. 

3  Click OK.

Increasing the CPU Usage Limit may slow 
down screen responses on slower computers.
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RTAS Engine (RTAS Error Suppression)

The RTAS Engine option determines RTAS error 
reporting during playback and recording. This is 
especially useful when working with instrument 
plug-ins.

You should only enable RTAS error suppression 
if you are experiencing frequent RTAS errors 
that are interrupting your creative workflow. 
When RTAS error suppression is enabled, you 
can experience a degradation of audio quality. 
However, this may be acceptable in order to 
avoid interrupting playback and recording 
when working with instrument plug-ins. Be sure 
to disable RTAS error suppression when you 
need to ensure the highest possible audio qual-
ity, such as for a final mix.

To enable RTAS error suppression:

1  Choose Setup > Playback Engine.

2  Select Ignore Errors During Playback/Record.

3  On Mac, you can also select Minimize Additional 
I/O Latency.

4  Click OK.



RTAS Error Suppression Options

Ignore Errors During Playback/Record When en-
abled, Pro Tools continues to play and record 
even if the RTAS processing requirements ex-
ceed the selected CPU Usage Limit. This can result 
in pops and clicks in the audio, but does not 
stop the transport.

Minimize Additional I/O Latency (Mac 
Only) When enabled, any additional latency due 
to suppressing RTAS errors during playback and 
record is minimized to 128 samples. Suppressing 
RTAS errors requires at least 128 samples of ad-
ditional buffering on some systems. If this op-
tion is disabled, the buffer is half the H/W Buffer 
Size, or at least 128 samples (whichever is 
greater). If you are on an older, slower computer, 
you may want to disable this option to avoid ad-
verse performance.

This option is only available on Mac if the Ignore 
Errors During Playback/Record option is enabled.

DAE Playback Buffer Size

The DAE Playback Buffer Size setting determines 
the amount of memory DAE allocates for disk 
buffers. In addition to levels, the DAE Playback 
Buffer Size shows values in milliseconds, which 
indicate the amount of audio buffered when the 
system reads from disk. 
The optimum DAE Playback Buffer Size for most 
disk operations is 1500 msec; Level 2 (Default). 

• DAE Playback Buffer Size settings lower than 
1500 msec; Level 2 (Default) may improve 
playback and recording initiation speed, as 
well as preview in context in DigiBase brows-
ers. However, a lower setting may make it dif-
ficult to play or record tracks reliably with 
sessions containing a large number of tracks 
or a high density of edits, or with systems that 
have slower or heavily-fragmented hard 
drives.

• DAE Playback Buffer Size settings higher than 
1500 msec; Level 2 (Default) allow higher track 
count, higher density of edits in a session, or 
the use of slower hard drives. However, a 
higher setting may increase the time lag when 
starting playback or recording, starting pre-
view in context from DigiBase browsers, or 
cause a longer audible time lag while editing 
during playback.

To change the DAE Playback Buffer Size:

1  Choose Setup > Playback Engine.

2  From the DAE Playback Buffer pop-up menu, se-
lect a buffer size. Memory requirements for each 
setting are shown at the bottom of the Playback 
Engine dialog.

3  Click OK. 

If Pro Tools needs more system memory for the 
DAE Playback Buffer, it will prompt you to re-
start your computer.

Using a larger DAE Playback Buffer Size 
leaves less system memory for other tasks. 
The default setting of 1500 msec (Level 2) is 
recommended unless you are encountering 
–9073 (“Disk too slow or fragmented”) 
errors. 
Chapter 7: Pro Tools Configuration 55



56
Cache Size

The Cache Size setting determines the amount 
of memory DAE allocates to pre-buffer audio for 
playback and looping when using Elastic Audio. 

Minimum Reduces the amount of system mem-
ory used for disk operations and frees up mem-
ory for other system tasks. However, perfor-
mance when using Elastic Audio features may 
decrease.

Normal Is the optimum Cache Size for most ses-
sions.

Large Improves performance when using Elastic 
Audio features, but it also decreases the amount 
of memory available for other system tasks, such 
as RTAS processing.

To change the Cache Size:

1  Choose Setup > Playback Engine.

2  From the Cache Size pop-up menu, select a 
disk cache size.

3  Click OK. 

Using a larger Cache Size leaves less system 
memory for other tasks. The default setting 
of Normal is recommended unless you are 
encountering -9500 (“Cache too small”) 
errors. 
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Plug-in Streaming Buffer Size

(Structure Plug-in Only)

This setting appears in the Playback Engine dia-
log only if Structure, Structure LE, or 
Structure Free is installed on your system. The 
Plug-in Streaming Buffer Size determines the 
amount of memory DAE allocates for streaming 
playback from disk with the Structure plug-in. 
This setting only affects playback if disk stream-
ing is activated in Structure’s plug-in controls 
(see the Structure Plug-in Guide for more informa-
tion).

The optimum Plug-in Streaming Buffer Size for 
most sessions is 250 ms (Level 2).

• Plug-in Streaming Buffer Size settings lower 
than 250 msec (Level 2) reduce the amount of 
system memory used for sample playback and 
frees up memory for other system tasks. How-
ever, audio quality of sample playback may 
decrease.

• Plug-in Streaming Buffer Size settings higher 
than 250 msec (Level 2) improve the audio 
quality of sample playback, but they also de-
crease the amount of memory available for 
other system tasks, such as RTAS processing.

To change the Plug-in Streaming Buffer Size:

1  Choose Setup > Playback Engine.

2  From the Plug-in Streaming Buffer Size pop-up 
menu, select a buffer size.

3  Click OK. 

Using a larger Plug-in Streaming Buffer Size 
leaves less system memory for other tasks. 
The default setting of 250 ms (Level 2) is 
recommended unless you are experiencing 
problems with the audio quality of sample 
playback.



Optimizing the Plug-in Streaming Buffer 
Size

(Structure Plug-in Only)

This option appears in the Playback Engine dia-
log only if one of the Structure sampler instru-
ment plug-in is installed on your system. This 
option is useful when you are playing samples 
from the same drive that contains audio for the 
current session. When this option is selected, 
Pro Tools automatically optimizes the size of the 
Plug-in Streaming Buffer to facilitate disk access 
for both Pro Tools and Structure. The Plug-in 
Streaming Buffer Size pop-up menu is unavail-
able when this option is selected.

To set Pro Tools to optimize the Plug-in Streaming 
Buffer Size:

1  Choose Setup > Playback Engine.

2  Select the Optimize for Streaming Content op-
tion.

3  Click OK. 
Pro Tools Hardware Settings

In the Hardware Setup dialog, Pro Tools lets you 
set the default sample rate and clock source for 
your system, as well as a range of controls spe-
cific to each type of audio interface.

Default Sample Rate

The Sample Rate setting appears as the default 
sample rate when you create a new session. (This 
setting is available in the Hardware Setup dialog 
only when no session is open.) The following 
sample rates are available:

• 44.1 kHz

• 48 kHz

• 88.2 kHz

• 96 kHz

To change the default Sample Rate:

1  Choose Setup > Hardware.

2  Select the sample rate from the Sample Rate 
pop-up menu.

3  Click OK.

You can change the sample rate when creat-
ing a new Pro Tools session by selecting a 
different sample rate in the New Session 
dialog. (Refer to the Pro Tools Reference 
Guide for details.)

Hardware Setup dialog for Eleven Rack
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Clock Source

The Pro Tools Hardware Setup dialog lets you se-
lect the Clock Source for the system.

Internal Use this setting if you are recording an-
alog signals directly into Eleven Rack, and/or are 
recording digital inputs into the AES/EBU or 
S/PDIF ports on Eleven Rack, where the digital 
device is synchronized to the appropriate digital 
output.

AES/EBU Use this setting if you are recording 
through the Eleven Rack AES/EBU inputs from 
an external digital device. This setting will syn-
chronize Pro Tools to that digital device.

S/PDIF Use this setting if you are recording 
through the Eleven Rack S/PDIF inputs from an 
external digital device. This setting will synchro-
nize Pro Tools to that digital device. 

To select the Clock Source:

1  Choose Setup > Hardware.

2  Choose the clock source from the Clock Source 
pop-up menu. 

3  Click OK. 

Your digital input device must be connected 
and powered on for Pro Tools to synchro-
nize to it. If your input device is not powered 
on, leave the Clock Source set to Internal.
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Digital Format

The Pro Tools Hardware Setup dialog lets you se-
lect the format of Eleven Rack’s digital I/Os.

 AES/EBU Use this setting if you are interfacing 
Eleven Rack with a digital device that uses the 
AES/EBU format.

S/PDIF Use this setting if you are interfacing 
Eleven Rack with a digital device that uses the 
S/PDIF format.

To select the Digital Format:

1  Choose Setup > Hardware.

2  Select which digital I/O port on Eleven Rack 
will be active under Digital Format. 

3  Click OK.

Configuring I/O Setup

Using the I/O Setup dialog, you can label 
Pro Tools LE input, output, insert, and bus signal 
paths. The I/O Setup dialog provides a graphical 
representation of the inputs, outputs, and signal 
routing of the Eleven Rack. 

Pro Tools LE has default I/O Setup settings that 
will get you started. Use the I/O Setup dialog 
only if you want to rename the default I/O 
paths.



To rename I/O paths in I/O Setup:

1  Choose Setup > I/O.

2  Click the Input, Output, Insert, or Bus tab to dis-
play the corresponding connections.

3  To change the name of a path or subpath, dou-
ble-click directly on the Path Name, type a new 
name for the path, and press Enter. 

4  Click OK.

Configuring MIDI Setup

If you plan to use any MIDI devices with Pro Tools, 
do one of the following:

On Mac, configure your MIDI setup with Au-
dio MIDI Setup.

– or –

On Windows, configure your MIDI setup with 
MIDI Studio Setup.

I/O Setup dialog for Eleven Rack

See the Pro Tools Reference Guide (Help > 
Pro Tools Reference Guide) for more infor-
mation on renaming I/O paths.
Backing Up your System 
Configuration

After configuring your system and Pro Tools, 
you should save an image of your system drive 
using a backup utility such as Norton Ghost. By 
doing this, you can quickly restore your system 
configuration and settings if you encounter any 
problems.

Optimizing a Mac System for 
Pro Tools
To ensure optimum performance with 
Pro Tools, configure your computer before using 
Pro Tools hardware and software.

Before configuring your computer, make sure 
you are logged in as an Administrator for the ac-
count where you want to install Pro Tools. For 
details on Administrator privileges in Mac OS X, 
refer to your Apple OS X documentation. 

For Windows System Optimization, see 
“Optimizing a Windows System for 
Pro Tools” on page 62.

Do not use the Mac OS X automatic Soft-
ware Update feature, as it may upgrade 
your system to a version of Mac OS that has 
not yet been qualified for Pro Tools. 

For details on qualified versions of Mac OS, 
refer to the latest compatibility information 
on the Digidesign website 
(www.digidesign.com/compatibility).
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Turning Off Software Update

To turn off the Software Update feature:

1  Choose System Preferences from the Apple 
menu and click Software Update.

2  Click the Software Update tab. 

3  Deselect Check for Updates.

Turning Off Energy Saver

To turn off the Energy Saver feature:

1  Choose System Preferences from the Apple 
menu and click Energy Saver.

2  Click the Sleep tab and do the following:

• Set the computer sleep setting to Never.

• Set the display sleep setting to Never.

• Deselect Put the hard disk(s) to sleep when 
possible option.

Setting Processor Performance

(Mac G5 Computers and G4 Powerbooks Only)

To set the Processor Performance:

1  Choose System Preferences from the Apple 
menu and click Energy Saver.

2  Click the Options tab and set Processor Perfor-
mance to Highest.
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Disable or Reassign Mac Keyboard 
Shortcuts Used by Pro Tools

To have the full complement of Pro Tools key-
board shortcuts, you need to disable or reassign 
any conflicting Mac OS X Keyboard Shortcuts in 
the Apple System Preferences, including the fol-
lowing:

• “Show Help menu”

• Under “Keyboard Navigation”

• “Move focus to the window drawer”

• Under “Dock, Exposé, and Dashboard”

• “Automatically hide and show the Dock”

• “All windows”

• “Application windows”

• “Desktop”

• “Dashboard”

• “Spaces”

• Under “Spotlight”

• “Show Spotlight search field” 

• “Show Spotlight window”

To disable or reassign Mac OS X keyboard 
shortcuts:

1  Choose System Preferences from the Apple 
menu and click Keyboard & Mouse. 

2  Click the Keyboard Shortcuts tab.

3  Do one of the following:

• Deselect the Mac OS X options that conflict 
with Pro Tools keyboard shortcuts.

– or –

• Assign different, non-conflicting keyboard 
shortcuts to the corresponding Mac OS X 
options.

For a complete list of Pro Tools keyboard 
shortcuts, see the Keyboard Shortcuts Guide 
(Help > Keyboard Shortcuts).



Reassign Spaces Keyboard Shortcuts

If you want to use Spaces, you should reassign 
the Spaces keyboard shortcuts to avoid conflicts 
with important Pro Tools keyboard shortcuts. 
You can reassign Spaces keyboard shortcuts to 
use a combination of modifier keys (Com-
mand+Option+Control+Shift) in addition to 
the default Spaces keyboard shortcut assign-
ments to avoid these conflicts.

To reassign Spaces keyboard shortcuts to use 
modifier key combinations that do not conflict 
with Pro Tools keyboard shortcuts:

1  Choose System Preferences from the Apple 
menu and click Exposé & Spaces. 

2  Click the Spaces tab.

3  Ensure that Enable Spaces is selected.

4  Press and hold Command+Option+Con-
trol+Shift and select “Control+Option+Shift+Com-
mand+F8” from the “To activate Spaces” pop-up 
menu.

5  Press and hold Command+Option+Con-
trol+Shift and select “Control+Option+Shift+Com-
mand+Arrow Keys” from the “To switch between 
spaces” pop-up menu.

6  Press and hold Command+Option+Con-
trol+Shift and select “Control+Option+Shift+Com-
mand+Number Keys” from the “To switch directly 
to a space” pop-up menu.
Disabling Spotlight Indexing

The Mac OS X Spotlight feature automatically 
indexes files and folders on local hard drives in 
the background. In most cases, this is not a con-
cern for normal Pro Tools operation. However, 
if Spotlight starts indexing drives while record-
ing in a Pro Tools session with high track counts 
for an extended period of time, it can adversely 
affect Pro Tools system performance. You may 
want to disable Spotlight indexing for all local 
drives before using Pro Tools for big recording 
projects.

To disable Spotlight indexing:

1  Choose System Preferences from the Apple 
menu and click Spotlight. 

2  In the Spotlight window, click the Privacy tab.

3  To prevent indexing of a drive, drag its icon 
from the desktop into the list.

Enabling Journaling for Audio Drives

To yield higher performance from audio drives, 
enable journaling.

To enable journaling:

1  Launch the Disk Utility application, located in 
Macintosh HD/Applications/Utilities.

2  Select the volume in the left column of the 
Disk Utility window.

3  Click Enable Journaling in the toolbar.

Disabling Spotlight indexing also disables 
the Find function in Mac OS X. 
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Optimizing a Windows System 
for Pro Tools
To ensure optimum performance with 
Pro Tools LE, configure your computer before 
using Pro Tools hardware and software.

Before configuring your computer, make sure 
you are logged in as an Administrator for the ac-
count where you want to install Pro Tools. For 
details on Administrator privileges, see your 
Windows documentation.

Required Optimizations

To ensure optimum performance with 
Pro Tools, configure the following settings be-
fore using Pro Tools hardware and software.

Enabling DMA

Enabling your computer's DMA (Direct Memory 
Access) frees up CPU bandwidth so your com-
puter can do other Pro Tools tasks.

In most cases the DMA option will already be set 
correctly, as Windows detects and activates 
DMA mode by default.

For Mac System Optimization, see “Opti-
mizing a Mac System for Pro Tools” on 
page 59.

When you are finished changing Windows 
system settings, restart your computer.
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To enable DMA for any IDE hard drives:

1  Right-click Computer (Windows Vista) or My 
Computer (Windows XP).

2  In the left-hand pane of the Computer Man-
agement window under System Tools, click on 
Device Manager.

3  In the right-hand pane, click the plus (+) sign 
to expand IDE ATA/API Controllers.

4  Right-click on the Primary IDE Controller and se-
lect Properties.

5  Click the Advanced Settings tab.

6  For each device, do one of the following de-
pending on your operating system:

• Check the box Enable DMA (Windows Vista)

– or –

• Set the Transfer Mode to DMA if available 
(Windows XP)

7  Click OK.

8  Repeat the above steps for any additional IDE 
Channels.

9  Close the Computer Management window.

Disabling System Standby and Power 
Management

When using Pro Tools, the Windows System 
Standby power scheme must be set to Always On. 
This helps prevent long record or playback 
passes from stopping due to system resources 
powering down. 



To configure Windows Power Management 
(Windows Vista):

1  Choose Start > Control Panel.

2  Double-click Power Options.

3  In the Power Options window, select High Per-
formance.

4  Click Change plan settings.

5  In the Edit Plan Settings window, click Change 
advanced power settings.

6  In the Power Options dialog, reveal Hard disk > 
Turn off hard disk after.

7  Click the Setting option.

8  Select the value in the Setting (Minutes) field 
and press Backspace on your computer key-
board.

9  Press Enter. The hard disk setting changes to 
Never and the Power Options dialog closes.

10  In the Edit Plan Settings window, click Save 
changes and close the window.

To configure Windows Power Management 
(Windows XP):

1  Choose Start > Control Panel.

2  Double-click Power Options.

3  Click the Power Schemes tab.

4  From the Power Schemes pop-up menu, select 
Always.

5  Verify that the following settings are set to 
Never:

• Turn off hard disks 

• System standby 

• System hibernates 

6  Click OK. 
Disabling User Account Control

(Windows Vista Only)

For optimal performance with Pro Tools on 
Windows Vista, disable User Account Control 
(UAC).

To disable User Account Control (UAC):

1  Choose Start > Control Panel.

2  Double-click User Accounts.

3  Click Turn User Account Control on or off.

4  Deselect the Use User Account Control (UAC) to 
help protect your computer option.

5  Click OK.

Recommended Optimizations

Pro Tools can also be affected by other software 
and hardware drivers installed on your com-
puter. For best possible performance, it is recom-
mended (but not required) that you do the fol-
lowing:

• Avoid running any unneeded programs at 
the same time as Pro Tools.

• Turn off any software utilities that run in 
the background, such as Windows Messen-
ger, calendars, and disk maintenance pro-
grams. 

• Turn off any non-essential USB devices 
while running Pro Tools.

• If your video display card supports it, en-
able Bus Mastering in the manufacturer’s 
Control Panel. See the manufacturer’s in-
structions for details.
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Optional Optimizations

The following system optimizations may help 
Pro Tools perform better on some systems. It is 
recommended that you only try these optimiza-
tions if necessary, as they may disable or ad-
versely affect the functionality of other pro-
grams on your system.

Disabling Network Cards

If applicable, disable any networking cards 
(other than a FireWire card that you might use 
to connect an external drive to your system).

To disable a network card:

1  Right-click Computer (Windows Vista) or My 
Computer (Windows XP) and choose Manage.

2  Under System Tools, select Device Manager.

3  In the Device Manager window, double-click 
Network adapters, then double-click the Network 
Adapter card you want to disable.

4  Under the General tab, choose “Do not use this 
device (disable)” from the Device Usage pop-up 
menu, and click OK.

5  Close the Computer Management window.
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Adjusting Processor Scheduling

To adjust Processor Scheduling performance:

1  Right-click Computer (Windows Vista) or My 
Computer (Windows XP) and choose Properties.

2  in the System Properties window, click the Ad-
vanced tab.

3  Under the Performance section, click the Set-
tings button.

4  In the Performance Options window, click the 
Advanced tab.

5  Under the Processor Scheduling section, select 
the Background Services option.

6  Under the Memory Usage section, select the 
System cache option.

7  Click OK to close the Performance Options 
window. 

8  Click OK to close the System Properties win-
dow.

9  Restart the computer for the changes to take 
effect.



Disabling System Startup Items

The fewer items in use by your computer, the 
more resources are available for Pro Tools. Some 
startup applications may be consuming unnec-
essary CPU resources, and can be turned off. 

If you disable any of the following startup items, 
do so carefully:

• Portable media serial number (required for 
some applications that utilize a copy pro-
tection key)

• The Plug and Play service

• Event log

• Cryptographic services

To Disable System Startup Items:

1  From the Start menu, type “msconfig” in Start 
Search (Windows Vista) or in Run (Windows XP) 
and click OK to open the System Configuration 
Utility.

2  Under the General tab, choose Selective 
Startup.

3  Deselect Load Startup Items and click OK.

4  Click Restart to restart the computer.

5  After restarting, the computer displays a Sys-
tem Configuration message. Check to see if 
Pro Tools performance has increased before you 
deselect the Don't show this message again op-
tion. If performance has not changed, run 
“msconfig” and return your computer Startup 
Selection back to Normal Startup - load all device 
drives and services. Alternatively, try disabling 
Startup items and non-essential processes indi-
vidually.
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Chapter 8: Eleven Rack Studio Setup

This chapter will take you through connecting and configuring Eleven Rack to work at its best with 
the other gear in your recording setup, like speakers, headphones, instruments and microphones. 
Figure 8.  Eleven Rack Studio Setup
This first section addresses the connections you’ll want to make when recording with Pro Tools LE. 
If you’re using Eleven Rack as a processor with a Pro Tools HD system, see “Using Eleven Rack with 
a Pro Tools|HD or M-Powered System” on page 71.
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Listen to Your Sound
To hear audio from Pro Tools, you will need to 
connect a set of speakers or a pair of headphones 
to Eleven Rack. Sound from Pro Tools cannot be 
played through your computer’s speakers or 
your computer’s sound output. 

Connecting the Main Outputs

The Main outputs on the back of Eleven Rack are 
male XLR connectors. To listen to audio coming 
from Eleven Rack, these outputs should be con-
nected to a set of monitor speakers (self-powered 
or with an external amplifier) or a mixer or 
monitor controller system.

Main outputs Left and Right output the audio 
that is routed to the Main Out L/R output path 
within Pro Tools. 

Connecting a Pair of Headphones

On the front panel of the Eleven Rack is a 
1/4-inch jack to connect a pair of headphones.

sThe Phones jack outputs the audio that is 
routed to the Main Out L/R output path within 
Pro Tools. 

Setting Monitor Volume

The Volume knob on the front of Eleven Rack 
adjusts the output volume of the Main outputs 
and the Headphone Outs simultaneously. You 
can offset the Headphone volume from the 

The signal coming out of the Main outputs 
is at line level (+4 dbu). Take care to use 
line-level (not mic-level) inputs when con-
necting Eleven Rack to a mixer.
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Main output volume (higher or lower) by 
changing the setting in User Options Mode. For 
more details, see “Headphone Volume” on 
page 94.

Analog Audio Inputs
Eleven Rack features three types of analog in-
puts. There is a dedicated guitar (instrument-
level) input, a stereo line input, and a mic-level 
input. Choose the input type that fits the signal 
you want to send to Pro Tools.

Connecting Your Guitar

Use the Guitar input for instruments such as 
electric guitar or electric bass that usually have a 
lower level of output than line level instru-
ments.

To connect a guitar or other instrument-level 
device to Eleven Rack:

Connect your instrument to the Guitar input 
on the front panel of Eleven Rack using a stan-
dard 1/4-inch TS guitar cable.

Connecting Line-Level Devices

Use the Line inputs for line level devices, such as 
keyboards, mixers, and mic preamps.

To connect a keyboard, mixer or other line-level 
device to Eleven Rack:

1  Plug your device into the Line inputs on the 
back panel of Eleven Rack using one or two stan-
dard 1/4-inch (TRS or TS) cables. If the device is 
mono, plug it into one of the Line inputs. If the 
device is stereo, plug it into both the left and 
right Line inputs with two cables.



2  Set your device’s output volume to its optimal 
level. For example, the optimal level for most 
keyboards is between 80% and 100% of maxi-
mum volume.

3  If your device has unbalanced (TS) outputs, set 
the line inputs on Eleven Rack to –10 dVB by 
toggling the Level switch between the Line in-
put jacks to its outward position. If your device 
has balanced (TRS) outputs, set the Line inputs 
to +4 dVB by toggling the Level switch to its in-
ward position.

Connecting a Microphone to 
Eleven Rack

Eleven Rack provides an XLR mic input. It can 
accept a microphone, DI box, or any other 
mic-level device.

Eleven Rack mic-level input and controls

Mic input Phantom
Power (48v)

On/Off

Pad 
On/Off
SwitchSwitch

Mic
Gain

Control
Switch
To connect a microphone or other mic-level device 
to Eleven Rack:

1  If using a microphone that may be damaged 
by phantom power (some ribbons, some tube 
condensers), flip the Phantom Power switch (la-
beled 48V) to OFF.

2  Plug your microphone cable into the Mic in-
put on the front of Eleven Rack.

3  If your microphone requires phantom power, 
make sure the microphone is connected, then 
flip the Phantom Power switch to ON.

4  Carefully turn the Gain control up to increase 
the input level of your microphone signal.

5  If the incoming signal seems too loud or 
sounds distorted, even with the Gain knob all 
the way down, flip the Pad switch to ON to en-
gage the –20 dB pad. 

6  On the front of the Eleven Rack, carefully turn 
the Gain control to the right to increase the in-
put level of your microphone signal. 

Digital Audio Input and Output
Eleven Rack provides digital inputs and outputs 
for AES/EBU and S/PDIF format digital audio de-
vices. You can use these connections to record 
from digital sources, use external digital effects, 
or send Pro Tools audio to an external digital re-
corder.

Eleven Rack can have devices connected to 
both the AES/EBU and S/PDIF ports simul-
taneously, but only one format of device can 
be used at one time. You can switch be-
tween these two formats from within Pro 
Tools LE, or from the front panel of Eleven 
Rack, if using it as a standalone processor.
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To connect a digital device to Eleven Rack, do one 
of the following:

• Connect the AES/EBU output on the device to 
the AES/EBU input on Eleven Rack, and the 
device’s AES/EBU input to Eleven Rack’s 
AES/EBU output, with two AES/EBU-format 
XLR cables.

– or –

• Connect the S/PDIF output on the device to 
the S/PDIF input on Eleven Rack, and the de-
vice’s S/PDIF input to Eleven Rack’s S/PDIF 
output port, using two 75-ohm coaxial cables 
with male RCA connectors on both ends.

Configuring Digital Devices

When connecting to external gear digitally, 
Eleven Rack and Pro Tools must be set to the 
same sample rate and digital format as your dig-
ital device. Pro Tools must also be set to clock 
from the digital device, or no audio can pass be-
tween them.

To configure Pro Tools to interface with a digital 
device: 

1  Choose Setups > Hardware Setup.

2  Select AES External or S/PDIF External from the 
Clock Source pop-up menu, to match with the 
device.

3  Change the sample rate of your external de-
vice to match the rate you are using or plan to 
use in your Pro Tools session. If your device op-
erates in a limited range of sample rates, you’ll 
need to stay within that range when choosing 
the sample rate for your Pro Tools session.

4  Click OK.
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At this point, you can try to record some signal 
from the digital device (if it is a sound source, 
like a keyboard or CD player), inserting it onto a 
pre-recorded track (if it’s an effects processor), 
and so on. 

MIDI Connections
The two MIDI ports on Eleven Rack let you take 
advantage of all the MIDI features of 
Pro Tools LE, including recording and editing 
MIDI data for to automate controls on Eleven 
Rack, and/or compose using virtual or hardware 
MIDI sound sources. 

If you need additional MIDI ports you can add a 
compatible USB-based MIDI interface to your 
system.

To connect a MIDI device to Eleven Rack:

1  Connect a standard 5-pin MIDI cable from the 
MIDI Out port of your device to the MIDI In 
port on the back of Eleven Rack.

2  If the device has a MIDI input and you plan to 
send MIDI signals to it from Pro Tools, connect 
another MIDI cable from the MIDI Out port on 
the back of Eleven Rack to the MIDI In port of 
your device.

If you get no signal or a compromised signal, 
double-check that Pro Tools and your exter-
nal device are set to the same sample rate and 
digital I/O format, and that Pro Tools is set 
to receive sync from the external device.

Eleven Rack MIDI connections

MIDI In

MIDI Out



Using Eleven Rack with a Pro Tools|HD or M-Powered System
Figure 9.  Eleven Rack connected to a Pro Tools|HD system

Analog I/O Digital I/O-or-

Pro Tools HD Audio Interface
Apart from its roles as a Pro Tools LE interface 
and standalone guitar processor, Eleven Rack 
can also be used alongside a Pro Tools|HD or 
Pro Tools M-Powered system, acting as a re-
mote-controlled processing system and guitar 
preamp.

You’ll need a digital or analog audio connection 
to and from the Pro Tools|HD or M-Powered sys-
tem to run audio through Eleven Rack. If you 
want to use the Eleven Rack Control window in 
Pro Tools to control Eleven Rack and manage 
Rigs, Eleven Rack must be connected to the 
computer using USB. 
You’ll also need to install the included Pro Tools 
HD or M-Powered software update, unless 
you’re already using version 8.0.1 or higher. 

The included update requires Pro Tools 8.0 
software to update from. If your HD or 
M-Powered system has not already been 
updated to at least Pro Tools version 8.0, 
you’ll need to purchase and install that 
upgrade before you can control Eleven Rack 
and manage Rigs from within Pro Tools. 
Visit www.digidesign.com for upgrade 
details.
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Audio Connections

To connect Eleven Rack to your Pro Tools 
interface using analog I/O:

1  Connect the Main outputs on Eleven Rack to 
an open pair of analog line inputs on your audio 
interface.

2  Hold the Edit/Back button on Eleven Rack to 
enter Edit mode.

3  Choose the input you need for the current 
task:

• If you want to re-amp pre-recorded signals 
through Eleven Rack, choose Line L+R.

– or –

• If you want to record an analog signal us-
ing Eleven Rack’s input circuitry and Rig 
processing, choose the Guitar, Mic, or Line 
option, to match the input you’re using.

4  Connect the Line inputs on Eleven Rack to an 
open pair of analog line outputs on your audio 
interface.

Press Edit/Back twice to return to the main Rig 
Select Screen.
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To connect Eleven Rack to your Pro Tools 
interface using AES/EBU or S/PDIF digital I/O:

1  Connect the Eleven Rack to an open pair of 
digital inputs and outputs on your audio inter-
face, either AES/EBU or S/PDIF.

2  Hold the Edit/Back button on Eleven Rack to 
enter User Options mode.

3  Select Rig Input, and press the SW1 button.

4  Choose the input you need for the current 
task:

• If you want to re-amp pre-recorded signals 
through Eleven Rack, choose Digital L+R.

• If you want to record an analog signal us-
ing the input circuitry and Rig processing 
in Eleven Rack, choose the Guitar, Mic, or 
Line option, to match the input you’re us-
ing.

5  Press Edit/Back to move back to the previous 
screen.

6  Select Digital Clock/Input, and press SW1.

7  Set the Clock Source to External.

8  Set the Digital Input to AES/EBU or S/PDIF, to 
match the type of connection you’re using.

9  Press Edit/Back to move back to the previous 
screen.

10  Select Digital Output, and press SW1.

11  Choose Rig Outputs.

12  Press Edit/Back twice to return to the main 
Rig Select Screen.



Configuring Your Pro Tools|HD or 
M-Powered System

First, you’ll need to install the correct Pro Tools 
software and connect Eleven Rack to your com-
puter using USB.

To configure your Pro Tools system to interface 
with Eleven Rack:

1  Install the included Pro Tools HD software up-
date from the supplied DVD, unless Pro Tools 
version 8.0.1 or higher is already installed.

2  Use the supplied USB cable (or another USB 
2.0 cable) to connect Eleven Rack to an open 
USB 2.0 port on your computer.

3  Launch Pro Tools. If the software has been in-
stalled correctly and Eleven Rack is connected 
via USB, the Eleven Rack Control window will 
open, giving you access to the controls and Rig 
management features.

A pre-existing installation of Pro Tools ver-
sion 8.0 or higher is required to install this 
update.

For more information on controlling Eleven 
Rack from Pro Tools, see “The Eleven Rack 
Control Window” on page 76.
Setting Eleven Rack Sample Rate and 
Clock Source

When Eleven Rack is connected to your com-
puter via USB, the sample rate and clock source 
can no longer be set from within the User Op-
tions mode on the front panel.

When connecting Eleven Rack to your Pro Tools 
system digitally, clock source must be set to Ex-
ternal, and the sample rate must match the rate 
of your current Pro Tools session. You can use 
the Digidesign Eleven Rack utility on your Mac 
or PC to change these settings. 

To access Eleven Rack’s sample rate and clock 
source settings when connected via USB: 

1  Open the Digidesign Eleven Rack utility:

• On Mac, open System Preferences from the 
Apple menu and choose Digidesign Eleven 
Rack.

– or –

• On Windows, click the Start button, choose 
Control Panel and double-click Digidesign 
Eleven Rack.

2  The Digidesign Eleven Rack Properties win-
dow will appear. 

3  Choose the desired clock source and sample 
rate.

4  Close the System Preferences window (Mac) or 
the Digidesign Eleven Rack Properties dialog 
(Windows) when finished.
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Chapter 9: Eleven Rack with Pro Tools
This chapter shows you how to take advantage 
of some of the unique features that Eleven Rack 
brings to Pro Tools. If you’ve never recorded 
with Pro Tools before, be sure to check out the 
Intro to Pro Tools Guide that comes with 
Eleven Rack.

Pro Tools LE Capabilities
Pro Tools LE on Mac or Windows provides the-
following capabilities with Eleven Rack:

• Eight channels of simultaneous audio input: 

• Stereo Rig output

• All analog inputs 

• Stereo digital input

• Six channels of simultaneous audio output:

• Main/Phones outputs 

• Output To Amp outputs

• Stereo digital output

• Playback of up to 48 mono or stereo digital au-
dio tracks, or a combination of playing back 
and recording up to 48 mono or stereo digital 
audio tracks, depending on the capabilities of 
your computer. 
• Up to 128 audio tracks (with up to 48 active 
tracks), 128 Auxiliary Input tracks, 64 Master 
Fader tracks, 256 MIDI tracks, and 32 Instru-
ment tracks per session. 

• 16-bit or 24-bit audio resolution, at sample 
rates up to 96 kHz. 

• Non-destructive, random-access editing and 
mix automation.

• Audio processing with up to 10 inserts per 
track (RTAS® plug-ins or hardware inserts). 

• Up to 10 sends per track.

• Up to 32 internal mix busses.

For complete information on recording in 
Pro Tools, see the Pro Tools Reference Guide.
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The Eleven Rack Control Window

The Eleven Rack Control window is a special window in Pro Tools that lets you control Eleven Rack 
entirely from your computer. It can be accessed when using Eleven Rack as an interface with 
Pro Tools LE, as well as when connected to a Pro Tools HD system for control over USB.

Figure 10.  Eleven Rack Control window (in Pro Tools LE)

Rig View

Effect preset

Control section

Master Control

(Showing the
selected effect’s

controls)

section

selector
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You can open the Eleven Rack Control window by choosing Window > Eleven Rack.



Accessing the Eleven Rack Control Window
When Pro Tools LE, HD or M-Powered is launched and Eleven Rack is connected to your computer 
using USB, The Eleven Rack Control window is displayed. You can always access it by clicking 
Window > Eleven Rack.

The Eleven Rack Control window can be minimized to a basic floating window. When minimized, it 
shows the Rig Library menu, basic monitoring controls and a button which activates the Tuner. 

Similar controls can be accessed from the Guitar panel in the top bar of controls in the Edit window. 
Click the small amplifier-shaped icon in the Guitar panel to open the Eleven Rack Control window.

Eleven Rack Control window, minimized

Guitar panel in Edit window control toolbar

The Guitar panel can be hidden and/or moved within the toolbar. For more details, see the Pro Tools 
Reference guide by selecting Help > Pro Tools Reference Guide.

Opens Eleven Rack
Control window
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Rig View Section

Figure 11.  Eleven Rack Control window (in Pro Tools LE)

Rig Settings Rig Utility settings

Effects name/ Selected
bypass button Effect
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Output 1
selector

selector
In the Rig View section, you can access all of the 
amp, cab, effects, and utility parameters of the 
current Rig, as well as load and save rigs to and 
from your computer.

Rig Settings

The Rig Settings section lets you load, access, 
and save Rigs to and from Eleven Rack and your 
computer. 

Rig name Save ButtonRig 
number
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Clicking on the Rig name brings up a menu 
where you can call up any Rig stored in the 
memory of Eleven Rack or in your computer, or 
load a Rig setting from an audio file with embed-
ded Rig data.

The chosen Rig will be loaded into Eleven Rack, 
and can then be edited via the Eleven Rack Con-
trol window or the front panel of Eleven Rack.

For info on embedding Rig data in audio, see 
“Embedding Rig Settings in Audio Regions” 
on page 84.

Load Rig from
Eleven Rack 

Load one (or all)
Rigs from compute

Load embedded
Rig from audio
Region



Clicking on the Rig number brings up the Rig Li-
brarian, an all-in-one view of all Rigs currently 
stored in the memory of Eleven Rack. 

The name shown in the Rig Librarian is that of 
the most recently loaded Rig. When changes are 
been made to the Rig, the Save button turns red 
and the Rig number and name are shown in ital-
ics.

To save the current state of your Rig Settings:

Click on the Save button. You can choose to 
save the changes you’ve made to a Rig on Eleven 
Rack, to a file on your computer, or save all of 
the Rigs currently on Eleven Rack to the com-
puter in one larger file.

The files you save to the computer can be sent to 
collaborators or brought with you as you work 
at other computers, so you always have access to 
your settings.

Rig Utility Settings

The Rig Utility settings section lets you control 
the True-Z impedance-matching circuitry, vol-
ume, tempo, and expression pedal functions for 
the current Rig. 

Rig Tempo

The Rig Tempo menu sets the tempo of the cur-
rent Rig. Set a tempo, and the time-based effects 
(tremolo, delay, etc) that are set to sync will fol-
low the new tempo. You can also choose to have 
Rig tempo sync to the tempo of your Pro Tools 
session.
When Pro Tools is set to manual tempo (ignor-
ing the Conductor track), and Eleven Rack is set 
to lock to Session tempo, changes in Rig tempo 
will shift the tempo of your Pro Tools session, 
and vice versa.

When Pro Tools is set to follow the Conductor 
track, and Eleven Rack is locked to Session 
tempo, any changes made in the Conductor 
track over time will be followed by Eleven Rack.

To lock Rig tempo to Pro Tools session tempo:

Click the small Lock icon next to the tempo 
display.

Exp. Pedal

The Exp. Pedal menu lets you set the behavior 
and assignment of an external expression pedal. 

Multiple FX

When set to Multiple FX, the button to the left 
of the assignment name will highlight. Clicking 
this button will bring up a window where you 
can edit up to four parameters that will be swept 
by the pedal simultaneously.
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Each of the four Configs can be set to one pa-
rameter of one of the devices in the Rig. The Toe 
and Heel settings govern the top and bottom of 
the sweep of the control. 

Output to Amp Selectors

The Output to Amp selectors let you choose 
what point in the signal path feeds Output To 
Amp outputs one and two, and set the output 
volume for each, to better match the input sen-
sitivity of the external amp or processor.

To set the volume of the signal sent to each To 
Amp output:

Left-click the chosen To Amp output selector, 
and adjust the volume using the fader.

To choose what signal feeds each To Amp output:

Right-click one of the To Amp Output selec-
tors, and do one of the following:

• If the selector you click is not yet assigned 
(greyed out), a menu is displayed, letting 
you choose to send the signal at the chosen 
location to Output to Amp output one, 
two, or both in stereo.

– or –

• If the selector you click is already assigned 
to an Output to Amp out (highlighted), 
you get a menu letting you assign that To 
Amp output to another point in the signal 
chain.

If you set the Heel number higher than the 
Toe number, the control can be swept in re-
verse.
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Amp/Cab, Effects and Pedal 
Settings

This section of the Rig View pane lets you reveal, 
select, move, and bypass all of the amp, cabinet, 
effects, and pedals in the current Rig. Click on a 
piece of gear to highlight it, and it will show up 
in the Control section below.

Bypassing Amps, Cabs, and 
Effects

You can toggle the various gear in the current 
Rig on and off by clicking the name of the 
desired element.

For more information on the functions of 
the amp, cab, and effects controls, “The 
Amps” on page 20, and “The Effects” on 
page 27.



Changing The Order

In the Rig View pane, you can change the order 
of the pedals and effects in the current Rig just 
like you can in the Rig View on Eleven Rack. Vi-
sualize the signal travelling from left to right 
through the signal chain.

To change the order of gear in the signal path:

1  Click and drag a device. 

2  Drop it into the desired position.

Selecting Effects

Most of the effects have more than one available 
model. 

To select a different effect:

Click the Effect selector beneath the desired 
Effect type, and choose a new model from the 
menu.

This section will take you through the features 
of the Control window.

Some items in the Rig have restrictions 
about where they can be placed. When 
dragging a restricted item (like the FX 
Loop), it will snap between the allowed 
spots.

For more information on signal routing, see 
“Don’t Forget to Save!” on page 32.
Control Section

When a device is highlighted in the Rig View 
pane, the controls of the device are shown in the 
Control section.

On the displayed device, you can turn the 
knobs, toggle the switches, and rock the pedals, 
and everything you do is transmitted to 
Eleven Rack, so you can hear the changes you 
make in real time.s

Effects Preset Selector

The Effects preset selector lets you save and re-
call preset settings for individual Eleven Rack ef-
fects, within Pro Tools. 

For example, if you’ve dialed in the perfect lead 
tone on the Tri-Knob Fuzz, you can save the set-
tings for that effect and recall them without 
having to save or load a new Rig.

These presets are handled by the same system 
(using the same file types and functions) that 
manages plug-in presets in Pro Tools.

For more information on working with pre-
sets, see the Pro Tools Reference Guide.
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Master Control Section

The Master Control section houses the controls 
and features that apply to all of Eleven Rack. 

Tuner

This tuner works like the one you can access us-
ing the front panel of Eleven Rack, but is much 
larger and easier to see when working in 
Pro Tools.

Input Selector

This menu lets you choose which input on 
Eleven Rack will be fed through the Rig. This can 
be a physical input, or the Re-Amp outputs from 
Pro Tools.

Figure 12.  Master Control section

For more information on the Tuner con-
trols, see “Tap Tempo/Tuner Button” on 
page 8.
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User Options Mode

Pressing the User Options button in the Master 
Control section brings up User Options mode, 
which lets you access many of the under-the-
hood options you normally would access using 
the User Options mode on Eleven Rack. 

Output Mute Buttons

These two buttons let you mute the Headphone 
output and the Main outputs on Eleven Rack 
from within Pro Tools.

This comes in handy when recording with a mi-
crophone while wearing headphones (mute the 
main outputs to cut out bleed from the speak-
ers), or when headphones might bleed into a re-
cording track (mute the headphones).

Main Volume Knob

This knob acts just like the Volume knob on the 
front panel of Eleven Rack, varying the overall 
output volume of the Main and Headphone out-
puts.

For more information on User Options 
Mode and the settings it provides access to, 
see “Exploring the User Options” on 
page 91.

For more information on these controls, see 
“Eleven Rack Front Panel” on page 7, and 
“User Options” on page 91.



Recording Guitars
The simplest way to record guitar with 
Eleven Rack is to simply plug in your guitar, cre-
ate a track in Pro Tools, and record the sound 
coming from the Rig.

To record guitar through the Rig to a track in 
Pro Tools:

1  Click on the Track menu in Pro Tools and se-
lect New.

2  In the New Tracks dialog, create one stereo au-
dio track.

3  Assign the input on the stereo track you’ve 
created to Interface > Eleven Rig L/R.

4  Record-enable the track.

5  Select a Rig in the Eleven Rack Control win-
dow, and tweak its settings, if necessary.

6  Press Record, then Play, in the Pro Tools trans-
port.

7  Record your guitar part.

Input selector

Record-enable
button
Recording Wet and Dry Signals

The Guitar Input on Eleven Rack shows up in 
Pro Tools as a standard mono input path (Guitar 
In). This input passes the guitar signal, unpro-
cessed, to Pro Tools, where it can be recorded as 
normal.

The guitar signal also passes through the pro-
cessing features of Eleven Rack, and the pro-
cessed stereo output from the amp, cabinet, mic 
and effects simulations shows up as a second, 
stereo input path in Pro Tools for monitoring 
and/or recording (Eleven Rig L and R). Thus, the 
dry guitar signal and the output of the Rig can 
be recorded onto separate tracks, for processing 
and editing flexibility.

This means that when recording guitars with 
Eleven Rack, you can decide on a tone you enjoy 
and record your parts, but retain a clean version 
of those parts as well. Later, if you decide you 
want a different sound, or simply want to stack 
different tones on top of one another, you can 
re-amp those original, unaffected guitar tracks 
through a different set of Rig characteristics on 
Eleven Rack, or even another external guitar 
setup.

To record wet and dry versions of a guitar part 
simultaneously for future re-amping:

1  Click on the Track menu in Pro Tools and 
select New.

2  In the New Tracks dialog, do one of the 
following:

• Create one mono audio track

– or –

• Create one stereo audio track.

3  Assign the input on the mono track you’ve 
created to Interface > Guitar In.

For information on the re-amping process, 
“Re-Amping” on page 86.
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4  Assign the input on the stereo track you’ve 
created to Interface > Eleven Rig L/R.

5  Record-enable the two tracks.

6  Select a Rig in the Eleven Rack Control win-
dow, and tweak its settings, if necessary.

7  Press Record, then Play, in the Pro Tools trans-
port.

8  Record your guitar part.

If you don’t plan to use the dry signal right 
away, you can make the mono track inactive 
and hide it, using the functions of the Tracks 
pane in the Edit window. 

The dry track will be hidden and will not play, 
but Pro Tools will retain the data for later use. 
You can access the track again at any time.

Embedding Rig Settings in 
Audio Regions
Despite the fact that we designed Eleven Rack to 
store Rig settings to your computer and to its in-
ternal memory, we felt there had to be a better 
way to keep track of which Rig settings you use 
as you track your guitar.

Pro Tools lets you embed the current Rig’s set-
tings into audio regions as you record them, so 
that you can retrieve that same setting for fur-
ther use later.

This can also be helpful when collaborating or 
bringing sessions or regions to a different system 
using Eleven Rack, because your settings travel 
with the files.

The Guitar In input signal will look quite 
low when compared to other recorded sig-
nals in Pro Tools. If you need to do intricate 
rhythmic editing, you may want to increase 
the vertical zoom level in the Edit window.
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To embed Rig settings in recorded audio:

1  Open the Eleven Rack Control window.

2  Click the User Options button. The Embed Set-
ting From menu appears.

3  Set the Embed Setting From menu to the input 
you plan to record through, such as 
Eleven Rig L/R.

4  Create an audio track, and set its input to the 
input you’ve chosen, using the Input selector.

5  Record enable the track.

6  Record your part.

The settings of the currently loaded Rig will be 
embedded in each audio region that is recorded 
from the input you select in the Embed Setting 
From menu. 

Audio regions with embedded Rig data are 
marked with a small guitar pick-shaped icon in 
both the Edit Window and the Region Browser 
in Pro Tools. 

This same method applies when using 
Eleven Rack with Pro Tools|HD or M-Pow-
ered system.

Audio region with guitar pick-shaped indicator icon

Indicator icon



Retrieving Embedded Rig Settings

You can access Rig settings from any region with 
embedded settings that has been recorded or im-
ported into your Pro Tools session. You can do 
this by selecting regions directly in the Edit win-
dow, or you can access any embedded region in 
the session using the Eleven Rack Control Win-
dow.

To load a Rig setting from a region in the Edit 
window:

1  Open the Edit window by clicking Window > 
Edit.

2  Locate the region you want to load Rig Set-
tings from.

3  Right-click the region and choose Load Guitar 
Rig Settings. 

4  The Rig is loaded into Eleven Rack and is 
ready to use.

Loading settings from a region in the Edit window
To load an embedded Rig setting from within the 
Eleven Rack Control Window:

1  Open the Eleven Rack Control window by 
clicking Window > Eleven Rack.

2  Click the Rig Settings menu.

3  Any regions with embedded Rig data will 
show up as a list at the bottom of the menu.

4  The Rig is loaded into Eleven Rack and is 
ready to use.

Choosing a region from the RIg Settings menu

Once you have retrieved a Rig setting from a 
region, you may want to save it to your com-
puter or the Eleven Rack memory.

Rig settings data can only be embedded in 
.WAV or .AIFF files. MP3 encoding strips 
audio files of their embedded Rig data, so be 
sure to choose .WAV or .AIFF format when 
exporting audio files with embedded Rig 
data.
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Re-Amping
Re-Amping is the process of sending pre-re-
corded audio (in this case, from within 
Pro Tools,) to an external guitar amplifier or ef-
fects unit, and then re-recording the processed 
audio to a new track.

This is sometimes done when a guitar track is re-
corded dry and the amp and effects sound is to 
be decided upon later (see “Recording Guitars” 
on page 83).

In the case of Eleven Rack, re-amping can be 
done one of two ways. 

• Tracks can be sent from Pro Tools into the on-
board guitar processor in Eleven Rack, and re-
recorded to a new track.

– or –

• Tracks can be sent from Pro Tools, out 
through the Output To Amp outputs on 
Eleven Rack, into one or more external guitar 
amps or processors, and then re-recorded 
through the microphone, line, or guitar in-
puts on Eleven Rack, depending on the type 
of external devices being used.

To re-amp a signal using the guitar processor in 
Eleven Rack:

1  Choose the track in Pro Tools to be re-amped 
(mono tracks only).

2  Create a send from the track to Interface > 
ReAmp L/R.

3  Create a new stereo audio track, and assign its 
input to Interface > Eleven Rig L/R.

4  In Pro Tools Edit window, click with the Selec-
tor tool at the beginning of the first audio region 
on the track to be re-amped.

5  Select a Rig in the Eleven Rack Control win-
dow, and adjust the settings as desired.
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6  Start recording in Pro Tools.

7  The audio from the chosen track will be pro-
cessed through Eleven Rack, and re-recorded to 
the new stereo Audio track.

To re-amp a signal using the Output To Amp 
outputs on Eleven Rack:

1  Choose the track in Pro Tools to be re-amped.

2  In the Eleven Rack Control window, choose 
what point in the signal chain will be fed to one 
or both of the To Amp outputs using the To Amp 
Output selectors.

3  Create a new audio track, and assign its input 
to match the device you are using to re-amp, as 
follows:

• If re-amping through a guitar amp and mi-
crophone, or a device with an XLR DI out-
put, select Interface > Mic In.

• If re-amping through a guitar-level stomp-
box or processor, select Interface > Guitar In.

• If re-amping through a processor with a 
line-level output, select Interface > Line In-
put L.

4  Set up and connect your chosen external amp 
and microphone and/or processor to the Output 
To Amp 1 (L) output and the appropriate input 
on Eleven Rack.

• If using the mic input, ensure that the gain 
and other settings (such as phantom power 
and pad) are set correctly.

• If using an amplifier and microphone in 
the same room as your Pro Tools system, be 
sure to turn off or mute your monitor 
speakers, to avoid feedback.

5  Record-enable the new mono track.

See “Output to Amp Selectors” on page 80 
for details.



6  In Pro Tools Edit window, click with the Selec-
tor tool at the beginning of the first audio region 
on the track to be re-amped.

7  Start recording in Pro Tools.

8  The audio from the selected track is sent out of 
Eleven Rack, processed through your amp or 
processor, and then re-recorded to the new Au-
dio track.

Controlling Eleven Rack 
Parameters with MIDI Data
Using MIDI tracks in Pro Tools, you can record 
real time changes to your Rig settings, edit 
them, and play them back to Eleven Rack. This 
can be quite powerful when re-amping signals 
through Eleven Rack.

In the following example, you’ll control the Rig 
Volume parameter in Eleven Rack with MIDI 
data from Pro Tools.

To control the Rig Volume on Eleven Rack with 
MIDI CC data from Pro Tools:

1  Create a MIDI track in Pro Tools.

2  Assign its output to Predefined > Eleven Rack > 
channel-1.

3  On Eleven Rack, press and hold the Edit but-
ton for 1 second to enter User Options mode.

4  Scroll with the Scroll wheel to MIDI, and press 
the SW1 switch.

5  Use the lit Control knob to choose a MIDI re-
ceive channel. In this example, use channel 1.

6  In the Pro Tools Edit window, select MIDI Vol-
ume in the Track View menu for the MIDI track 
you’ve created. You’ll see a line running across 
the track. This is the MIDI CC envelope.
7  With the Pencil tool, draw a curving line from 
the beginning of the track to a point around 10 
seconds later.

8  Press Play on the Pro Tools transport. You will 
see the Rig Volume setting on the Eleven Rack 
Control window move in time to match the 
curve you’ve drawn.

This technique can be used for any of the MIDI 
CC controls Eleven Rack can respond to.

For a full list of MIDI CC data that Eleven 
Rack can accept, “Eleven Rack MIDI Con-
tinuous Controllers” on page 95.

For more information on using MIDI CC 
data in Pro Tools, see the Pro Tools Refer-
ence Guide, which can be accessed from 
within Pro Tools by selecting Help > Pro 
Tools Reference Guide.
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Chapter 10: User Options
This section describes the details of the User Op-
tions mode within Eleven Rack. User Options 
mode lets you access the behind-the-scenes con-
trols in Eleven Rack.

Exploring the User Options
Let’s start looking into the changes you can 
make using User Options.

To explore User Options mode from the front panel 
of Eleven Rack:

1  Press and hold the Edit/Back button until the 
User Options screen appears.

2  Turn the Scroll wheel to select the option you 
want to change.

3  Press the SW1 button to access the controls for 
that option.

4  Press Edit/Back once to return to the User Op-
tions menu, or twice to exit User Options mode 
and return to the previous screen.

User Options mode
To explore User Options mode when using Eleven 
Rack with Pro Tools:

1  Show the Eleven Rack Control window, by 
clicking Window > Eleven Rack.

2  Press the User Options button on the Control 
window.

User Options
This section lists and defines the available op-
tions in the User Options menu.

These descriptions and parameter names 
match those within the display on Eleven 
Rack. The Eleven Rack Control window’s 
User Options mode contains most of these 
controls, but some are named slightly differ-
ently.
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Rig Input

This setting lets you specify which input on 
Eleven Rack will be routed through the Rig. This 
can be set any of the analog or digital inputs on 
Eleven Rack, or the signal sent to the Re-Amp 
output in Pro Tools LE.

Outputs To Amp

In this page, you can what signal feeds the Out-
put To Amp outputs. Turn the Scroll wheel to 
switch between controlling Output 1 or Output 
2. If you want to use the Outputs To Amp in ste-
reo, you may want to match the controls for 
both channels.

Signal

Using the Signal control, you can set what point 
in the signal path feeds each Output to Amp 
output:

Rig Input The clean, unprocessed guitar signal, 
as is present at the input of the Rig.

Amp Input The signal after any processing that 
occurs before the Amp model in the signal 
chain.

 For more information on Re-Amping, see 
“Re-Amping” on page 86

Running the mic input through the Rig with 
your monitor speakers on can result in se-
vere feedback, due to the amount of gain 
available in the amp and effects emula-
tions. Be sure to mute or turn down the 
main outputs before proceeding.
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Amp Output The signal after passing through the 
amp emulation, but before the cab, mic, and 
any effects emulations placed after the amp in 
the signal path.

Rig Output The fully processed signal, run 
through every part of the current Rig (including 
cab and mic emulation).

Rig Out No Cab The fully processed signal, with 
the Cab model automatically bypassed. 

Digital Clock/Input

When Eleven Rack is being used standalone and 
is not plugged into a computer, it lets you 
choose the clock source (internal or external), 
sample rate (if using internal clock), and digital 
format you want to work with.

Clock Source Lets you choose between the fol-
lowing clock sources:

• Int 44.1 kHz (Internal clock)

• Int 48 kHz (Internal clock)

• Int 88.2 kHz (Internal clock)

• Int 96 kHz (Internal clock)

• External 

Digital Input Lets you choose the digital format 
you want to use for input, either AES/EBU, or 
S/PDIF.

When feeding signal to a external guitar 
amplifiers, it is generally preferred to apply 
no cab and mic emulation to the signal. 
Since the speaker being driven by the ampli-
fier will naturally shape the tone of your 
signal, using the cab and mic emulations in 
Eleven Rack will produce compromised 
results.



When Eleven Rack is plugged into a computer 
with USB for use with Pro Tools LE or HD, these 
options must be set in the host software 
(Pro Tools LE or other). The Digital Clock/Input 
screen will just show the current settings and 
whether or not there is a valid clock signal pres-
ent at the currently chosen digital input.

Digital Output

Adjust the Output control to choose the type of 
signal being passed to the digital outputs.

DAW  The output from the Digital Out L/R out-
put path in Pro Tools LE will be sent to the digi-
tal outs.

Mirror Analog The same signal that is being sent 
to the Main Outputs will be sent to the digital 
outs.

Rig Outputs The left and right Rig outputs are 
sent to the left and right digital outputs respec-
tively.

Split In/Out The left and right Rig outputs are 
summed and sent to the left digital output, and 
the signal as present at the Rig input (the “dry” 
signal) is sent to the right digital output.

 For more information on how to access 
these controls from within Pro Tools LE, see 
“Pro Tools Hardware Settings” on page 57.
FX Loop

The FX Loop screen is where you control the 
mono/stereo behavior of the FX loop. Set the 
control to Mono if using a mono effect, to Mono 
to Stereo, if using an effect that takes a mono 
signal but has a stereo output, or Stereo, if using 
a true stereo effects unit.

External Pedals

This screen lets you set up an expression pedal 
or a dual footswitch, plugged into the Exp 
Pedal/Ext Footswitch jack on the back of Eleven 
Rack.

Turn the Scroll wheel to select the type of pedal 
you’ll be using. In expression pedal mode, you 
can press SW1 to enter calibration mode. Follow 
the on-screen instructions to calibrate your ex-
pression pedal. In Dual Footswitches mode, you 
can use the Tone Control knobs to select a func-
tion for each footswitch.

Each footswitch can be set to do one thing, 
whether it’s cycling through Rigs, turning a cer-
tain effect on and off or just bringing up the 
tuner.

MIDI 

The MIDI page lets you set up how Eleven Rack 
responds to MIDI data.

Channel Sets the MIDI receive and send channel, 
from 1-16.

Thru Toggles MIDI thru on and off.

CC When engaged, front-panel control changes 
will send corresponding MIDI CC messages to 
Pro Tools, and be output through the MIDI out-
put jack.
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Rig Balancing

This screen lets you adjust the relative signal 
level of each of the saved Rigs. If you find that a 
certain Rig is much louder or quieter than the 
others, you can tweak it here. 

Turn the scroll wheel to select a Rig to adjust, 
and use the lit Tone Control knob to adjust the 
volume.

When you’re done editing these settings and 
you back out of the Rig Balancing screen, a “Sav-
ing” message appears on the display for a few 
moments as the new settings are saved.

Amp/Cab Linking

This parameter toggles the linking of amplifier 
and cabinet models that were historically used 
together. With Amp/Cab Linking on, when you 
choose certain amps in Rig View, the cabinet 
that goes with it will also be chosen. You can 
still change the cabinet you want to use later.

Display Contrast

This control allows you to set the contrast of the 
LCD display to match your viewing angle or 
light conditions. 

Knob Display/Action

This screen lets you configure the way knob set-
tings are displayed onscreen, and how they act.

Display

This control lets you see the current positions of 
the control knobs as either graphic knobs or as 
numeric values. If you choose to display the 
controls as knobs, keep in mind that you can see 
the exact numeric value of a control temporarily 
by turning the knob slightly.
Eleven Rack User Guide
Action

This control lets you choose between the follow-
ing knob behaviors:

Normal  Moving a Control knob will cause the 
currently assigned setting to immediately follow 
the knob’s position.

Latch When a Control knob is positioned differ-
ently than the current value of the assigned con-
trol, the control’s setting will not update until 
the knob is swept past the current setting.

Blink

The Tempo button on the front panel of 
Eleven Rack can be set to blink in time with the 
current Rig tempo. The Blink control toggles 
this behavior on and off.

Headphone Volume

This control sets the volume of the Headphone 
outputs on Eleven Rack, as an offset from the 
Main output volume.

Reset Memory

In this screen, pressing SW1 will reset the mem-
ory of Eleven Rack back to factory specs. All user-
created Rigs and settings will be erased.

You can exit this screen without resetting the 
memory by pressing the Edit/Back button.

Firmware Version

On this screen, you can check to see what firm-
ware version is running on your Eleven Rack.



Chapter 11: Controlling Eleven Rack 
with MIDI

Many of the parameters in Eleven Rack can be controlled using MIDI. This opens up the possibility of 
using both external MIDI devices (such as foot controllers) and the MIDI capabilities of Pro Tools to 
vary Eleven Rack’s tonal aspects in real time. 

This section lists the available MIDI controls for use with Eleven Rack.

Eleven Rack MIDI CC Controllers

Table 12. Eleven Rack MIDI Continuous Controllers
CC# Parameter Notes Minimum Value Maximum Value

3 Amp Setting 8 0 127

4 Wah Pedal 0 127

5 FX1 Setting 9 0 127

7 Volume Pedal 0 127

9 FX1 Setting 10 0 127

10 Amp Setting 6 0 127

11 Multi-FX 0 127

12 FX1 Setting 11 0 127

13 Amp Setting 1 0 127

14 Amp Setting 2 0 127

15 Amp Setting 3 0 127

16 Amp Setting 4 0 127

17 Rig Volume 0 127

18 Reverb Setting 1 0 127

19 FX Loop Send 0 127

20 FX1 Setting 1 0 127
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21 Amp Setting 5 0 127

22 Amp Setting 12 0 127

23 Amp Setting 11 0 127

24 Amp Setting 10 0 127

25 Distortion On/Off 0~63=Off ; 64~127=On 0 127

26 FX1 Setting 12 0 127

27 Distortion Setting 1 0 127

28 Delay On/Off 0~63=Off ; 64~127=On 0 127

29 FX1 Setting 13 0 127

30 FX1 Setting 14 0 127

31 Delay Setting 14 0 127

32

33 Delay Setting 2 0 127

34 Delay Setting 6 0 127

35 Delay Setting 3 0 127

36 Reverb On/Off 0~63=Off ; 64~127=On 0 127

37 FX2 Setting 8 0 127

38 Reverb Setting 2 0 127

39 Reverb Setting 4 0 127

40 Reverb Setting 3 0 127

41 Reverb Setting 6 0 127

42 FX1 Setting 2 0 127

43 Wah On/Off 0~63=Off ; 64~127=On 0 127

44 Amp Settings 13 0 127

45 Amp Settings 14 0 127

46 FX2 Setting 9 0 127

47 FX2 Setting 10 0 127

48 Delay Setting 7 0 127

49 Delay Setting 8 0 127

50 Modulation On/Off 0~63=Off ; 64~127=On 0 127

51 Modulation Setting 6 0 127

52 Modulation Setting 2 0 127

53 Modulation Setting 3 0 127

54 Modulation Setting 4 0 127
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55 Delay Setting 9 0 127

56 Modulation Setting 7 0 127

57 Modulation Setting 5 0 127

58 FX2 Setting 11 0 127

59 Delay Setting 10 0 127

60 FX1 Setting 3 0 127

61 Modulation Setting 1 0 127

62 Delay Setting 1 0 127

63 FX1 On/Off 0~63=Off ; 64~127=On 0 127

64 Tap Tempo 64-127 = a Tap

69 Tuner On/Off 0~63=Off ; 64~127=On 0 127

70 FX2 Setting 14 0 127

71 Cab Sim On/Off 0~63=Off ; 64~127=On 0 127

72 Delay Setting 11 0 127

73 Delay Setting 12 0 127

74 Delay Setting 13 0 127

75 Volume Pedal On/Off 0~63=Off ; 64~127=On 0 127

76 Reverb Setting 5 0 127

77 FX1 Setting 4 0 127

78 Distortion Setting 2 0 127

79 Distortion Setting 3 0 127

80 Distortion Setting 4 0 127

81 Distortion Setting 5 0 127

82 Distortion Setting 6 0 127

83 Distortion Setting 7 0 127

84 Amp Setting 9 0 127

85 Delay Setting 4 0 127

86 FX2 On/Off 0~63=Off ; 64~127=On 0 127

87 Delay Setting 5 0 127

88 FX Loop Mix 0 127

96 FX2 Setting 4 0 127

97 FX2 Setting 5 0 127

98 FX2 Setting 6 0 127

99 FX2 Setting 7 0 127
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101 Knob 1 0 127

102 Knob 2 0 127

103 Knob 3 0 127

104 Knob 4 0 127

105 Knob 5 0 127

106 Knob 6 0 127

107 FX Loop On/Off 0~63=Off ; 64~127=On 0 127

108 FX Loop Return 0 127

109 FX2 Setting 12 0 127

110 FX2 Setting 13 0 127

111 Amp On/Off 0~63=Off ; 64~127=On 0 127

112 Amp Setting 7 0 127

113 FX2 Setting 1 0 127

114 FX2 Setting 2 0 127

115 FX2 Setting 3 0 127

116 FX1 Setting 5 0 127

117 FX1 Setting 6 0 127

118 FX1 Setting 7 0 127

119 FX1 Setting 9 0 127
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All unused continuous controllers have been omitted from this list.



Chapter 12: Hard Drive Configuration 
and Maintenance
It is recommended that you start with a newly 
formatted external or secondary internal audio 
drive. You should also periodically defragment 
your audio drive to ensure continued system 
performance.

Avoid Recording to the 
System Drive
Recording to your system drive is not recom-
mended. Recording and playback on a system 
drive may result in lower track counts or fewer 
plug-ins.

Always back up any important data on your 
drive before formatting it, as it will erase all 
data on the drive.
Supported Drive Formats and 
Drive Types

Drive Formats

Mac Mac systems should use drives formatted 
with HFS+ or HFS file system only.

Windows Windows XP systems should use drives 
formatted as NTFS only.

Hard drive performance depends on factors in-
cluding system configuration, number of tracks, 
session sample rate, density of edits, and the use 
of crossfades and other processes such as Beat 
Detective in a session. 

For complete hard drive requirements, visit the 
Digidesign website at: 

www.digidesign.com/compatibility

HFS drives are supported as Transfer drives 
only.

Windows systems can also support Mac 
drives formatted with HFS+ system (also 
commonly referred to as Mac OS Extended). 
Refer to the Pro Tools Reference Guide for 
more information (Help > Pro Tools Refer-
ence Guide).
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SCSI Hard Drives

Digidesign recommends qualified SCSI hard 
drives and a qualified SCSI host bus adapter 
(HBA) card or (on Windows systems) a qualified 
built-in SCSI HBA connector on the mother-
board.

For complete information on track count and 
the supported number and configuration of 
SCSI drives, visit the Digidesign website at: 

www.digidesign.com/compatibility

FireWire Hard Drives

Digidesign recommends qualified FireWire 
drives and (on Windows systems) a qualified 
FireWire host adapter.

For complete information on track count and 
the supported number and configuration of 
FireWire drives, visit the Digidesign website at: 

www.digidesign.com/compatibility

IDE/ATA/SATA Hard Drives

A qualified internal IDE/ATA/SATA drive may be 
used as a dedicated audio drive. 

For complete information on track count with 
internal drives, visit the Digidesign website at: 

www.digidesign.com/compatibility

Formatting an Audio Drive

Formatting Mac Audio Drives

For optimum performance, audio drives should 
be formatted as Mac OS Extended (Journaled). 

To format an audio drive: 

1  Launch the Disk Utility application, located in 
Macintosh HD/Applications/Utilities.
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2  Click the Erase tab. 

3  Select the drive you want to initialize in the 
column on the left side of the window. 

4  Choose the Mac OS Extended (Journaled) for-
mat. 

5  Type a name for the new volume. 

6  If you plan to connect the drive to a Mac OS 9 
computer, select Install Mac OS 9 Drivers. 

7  Click Erase.

The drive appears on the Desktop with the new 
volume name.

Formatting Windows Audio Drives

For optimal performance, audio drives should 
be formatted as NTFS.

Disk Utility (Mac OS X)

Do not choose the “Case-Sensitive” format 
option. Pro Tools will not operate properly 
with case-sensitive formatted drives.

Pro Tools only supports Basic drive types. 
Do not convert the drive to a Dynamic type. 



To format an audio drive:

1  Right-click Computer (Windows Vista) or My 
Computer (Windows XP) and choose Manage.

2  Under Storage, choose Disk Management.

3  If the volume is “Healthy,” do the following:

• In the Disk Management window, right-
click the hard drive you will use for audio 
and choose Format.

• In the Format window, name the volume.

• Choose a file system. For optimum perfor-
mance, audio drives should be formatted as 
NTFS.

• Select Perform a quick format.

• Make sure Enable file and folder compression 
is not selected.

• Set the Allocation unit size to Default.

• Click OK.

Disk Management window (Windows XP)

Healthy volumes are volumes that have pre-
viously been partitioned and formatted.
4  If the volume is “Unallocated,” do the follow-
ing:

• In the Disk Management window, Right-
click the hard drive you will use for audio 
and choose New Partition.

• In the New Partition Wizard window, click 
Next.

• When prompted, select the partition type.

• Follow the on-screen instructions to select 
a partition size and other partition settings.

• When prompted, choose a file system. For 
optimum performance, audio drives 
should be formatted as NTFS. 

• Select Perform a quick format.

• Make sure Enable file and folder compression 
is not selected.

• Set the Allocation unit size to Default.

• Click OK.

Partitioning Drives
Partitioning creates a logical volume or volumes 
on a physical drive, almost as if you were creat-
ing virtual hard drives. Partitions can then be 
formatted with the appropriate file system 
(NTFS for Windows, HFS+ for Mac). 

Digidesign recommends using Primary par-
titions, instead of Extended partitions.

Mac OS allows drives larger than 4096 MB 
to be seen as whole volumes. Drives must be 
initialized with a disk utility that recog-
nizes the 2 terabyte limit. Single Pro Tools 
audio files cannot exceed 3.4 GB in size.

Windows XP allows drives formatted with 
the NTFS file system to be seen as whole 
volumes. Single Pro Tools audio files can-
not exceed 3.4 GB in size.
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Seek Times on Partitioned Drives

Seek times are actually faster on partitioned 
drives (assuming that reads and writes are per-
formed on a single partition), since the heads 
only have to seek within the partition boundar-
ies, rather than the whole capacity of the drive.

Smaller partitions perform faster than larger par-
titions, but this comes at the expense of contig-
uous storage space. When you partition a drive, 
you will need to find the compromise that best 
suits your performance and storage require-
ments. 

Defragmenting an Audio Drive

Mac Systems

When working with larger files (such as video), 
you can limit fragmentation by backing up your 
important files to another disk, erasing the files 
from the original hard disk, then copying the 
files back, instead of doing a defragmentation.

Window Systems

Periodically defragment audio drives to maintain 
system performance. 

For maximum recording and playback effi-
ciency, data should be written to your hard 
drive in a contiguous fashion—minimizing the 
seek requirements to play back the data. Unfor-
tunately, your computer can’t always store the 
sound files in this way and must write to disk 
wherever it can find space.

Avoid distributing audio files within a ses-
sion over different partitions on the same 
drive since this will adversely affect drive 
performance.
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In multitrack recording, audio tracks are written 
in discrete files, spaced evenly across the disk. 
While fragmentation of individual files may be 
zero, the tracks may be far enough apart that 
playback will still be very seek-intensive. Also, 
the remaining free space on the disk will be dis-
contiguous, increasing the likelihood of file 
fragmentation on subsequent record passes.

Increased fragmentation increases the chance of 
disk errors, which can interfere with playback of 
audio, and result in performance errors.

Optimizing (Defragmenting) Drives

To prevent fragmentation, you can optimize 
your drive, which rearranges your files into a 
contiguous format. Most optimizing software 
lets you run a check on a drive to find out the 
percentage of fragmentation. If your drive 
shows moderate to heavy fragmentation, you 
should consider optimizing it.

If you use your system for intensive editing, or if 
you frequently delete audio or fade files from 
your hard drive, you may need to optimize your 
drives on a weekly basis, or even every few days, 
since it doesn’t take long for even a large hard 
drive to become fragmented.

Backing Up Data Before Optimizing

Since your files will be rewritten by the optimi-
zation process, always make a backup copy of 
the data on your hard drive before you optimize 
it. You should also use a hard drive utility to find 
and repair any problems before optimizing data 
or re-initializing your drives. If there is any dam-
age to your hard drive's directories prior to opti-
mizing, serious data loss may result.

On Windows, to avoid fragmentation, for-
mat drives with higher cluster sizes (such as 
32K).



Defragmenting Windows Audio Drives

To defragment an audio drive (Windows Vista):

1  Choose Start > Control Panel.

2  Click System and Maintenance.

3  Click Performance Information and Tools.

4  Click Advanced Tools.

5  Click Open Disk Defragmenter.

6  In the Disk Defragmenter window, click the 
Defragment Now button.

To defragment an audio drive (Windows XP):

1  Right-click My Computer and choose Manage.

2  Under Storage, choose Disk Defragmenter.

3  In the Disk Defragmenter window, choose the 
drive you want to defragment

4  Click the Defragment button and follow the 
on-screen instructions.

When defragmenting is complete, close the 
Computer Management window.

The Defragment Now command defrag-
ments all your hard drives. This can take a 
lot of time, especially on systems with mul-
tiple drives. 

Advanced users can use the command line 
tool Defrag.exe to defragment individual 
drives. See your Windows Vista documen-
tation for more information.
Using Mac Drives on Windows 
Systems
Pro Tools for Windows lets you record and play 
back sessions directly from a Mac-formatted 
(HFS+) drive connected to a Windows system. 
This functionality requires that all Mac session 
and audio files be stored on Mac-formatted 
drives.

During Pro Tools installation, make sure to se-
lect the Mac HFS+ Disk Support option. This op-
tion lets your Pro Tools system read, write, re-
cord, and play back using Mac-formatted HFS+ 
disks.

Formatting and Maintaining HFS+ 
Drives

To format and partition any drives as HFS+, con-
nect the drives to a Mac computer and use the 
Apple OS X Disk Utility. 

For information on using the Mac HFS+ 
Disk Support option, see the HFS+ Disk Sup-
port Option Guide.

For information on sharing sessions be-
tween Mac and Windows systems, see the 
Pro Tools Reference Guide (Help > 
Pro Tools Reference Guide).
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Hard Disk Storage Space
Mono audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 
5 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 
7.5 MB per minute. 

Stereo audio tracks recorded with 16-bit resolution at 44.1 kHz (CD quality) require approximately 
10 MB of hard disk space per minute. The same tracks recorded with 24-bit resolution require about 
15 MB per minute.

Table 13 lists the required disk space for certain track numbers and track lengths, to help you estimate 
your hard disk usage.
Table 13. Required hard drive space for audio tracks (44.1
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kHz and 48 kHz sessions shown)
Number of Tracks and Length 16-bit at 
44.1 kHz

16-bit at 
48 kHz

24-bit at 
44.1 kHz

24-bit at 
48 kHz

1 mono track, 1 minute 5 MB 5.5 MB 7.5 MB 8.2 MB

1 stereo track (or two mono 
tracks), 5 minutes

50 MB 55 MB 75 MB 83 MB

1 stereo track (or two mono 
tracks), 60 minutes

600 MB 662 MB 900 MB 991 MB

24 mono tracks, 5 minutes 600 MB 662 MB 900 MB 991 MB

24 mono tracks, 60 minutes 7 GB 7.8 GB 10.5 GB 11.6 GB

32 mono tracks, 5 minutes 800 MB 883 MB 1.2 GB 1.3 GB

32 mono tracks, 60 minutes 9.4 GB 10.4 GB 14 GB 15.4 GB

48 mono tracks, 5 minutes 1.2 GB 1.3 GB 1.8 GB 1.9 GB

48 mono tracks, 60 minutes 14 GB 15.6 GB 21 GB 23.2 GB
Double the 44.1 kHz hard drive space re-
quirement when recording at 88.2 kHz, and 
double the 48 kHz numbers when recording 
at 96 kHz.



Chapter 13: Troubleshooting
Backing Up Your Work
It is highly recommended that you back up your 
work on a regular basis, and especially before 
making changes to your system configuration.

Backing Up Your Session Data

Back up your session and audio data frequently. 
There are a variety of media that are suited to 
back up projects of various sizes, from auto-
mated tape backup systems to high-capacity op-
tical drives, or to CD burners.

The best way to back up an entire session is to 
use the Save Copy In command. This command 
lets you save the session file and all of its associ-
ated files to a new location.

Backing Up Your System 
Configuration

After configuring your system and Pro Tools, 
you should save an image of your system drive 
using a backup utility such as Norton Ghost 
(Windows) or Bombich Carbon Copy Cloner 
(Mac). By doing this, you can quickly restore 
your system configuration and settings if you 
encounter any problems.

You can also use the Auto Save Backup fea-
ture (in the Operation Preferences page) to 
have Pro Tools automatically save backups 
of the session file while you work.
Common Issues

Pro Tools Won’t Launch

Problem

When you double-click the Pro Tools applica-
tion or a Pro Tools session file, Pro Tools doesn’t 
launch, or displays an error message. 

Possible Solutions

Check to be sure your computer has the re-
quired amount of RAM to launch Pro Tools.

Try a complete restart. Turn off your audio in-
terfaces, computer peripherals and your com-
puter, and then turn them on again in the 
proper sequence.

If you tried to launch Pro Tools by double-
clicking a Pro Tools session file, do the follow-
ing:

• Close any error message.

• Double-click the Pro Tools application.

• In Pro Tools, choose File > Open Session to 
open the session.

Reinstall the Pro Tools application, using the 
Pro Tools Installer disc.
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Audio Interface Is Not Recognized

Problem

When you launch Pro Tools it does not recog-
nize an audio interface, or a connected audio in-
terface is not available.

Possible Solutions

Turn off your computer and Eleven Rack (re-
member to save first!) and check to be sure your 
cables are properly and securely connected to 
your computer and to your audio interface.

Verify that your Hardware Setup dialog set-
tings are correct.

Performance Factors
There are several conditions that may adversely 
affect the performance of Pro Tools. These in-
clude:

Network Connections Close any network con-
nections unless you are using them for network 
interchange of audio data.

Background Applications Any software utilities 
that run in the background or generate disk ac-
tivity, such as virus protection, disk optimiza-
tion, or file savers, should be turned off or re-
moved.

Screen Savers Screen saver software should be 
completely disabled on your computer before 
running Pro Tools.

Power Saver Features Some automatic power 
saver features, such as those that spin down the 
system hard drive, can affect Pro Tools perfor-
mance. These features should be turned off.
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Before You Call Digidesign 
Technical Support

Register Your System

Register your purchase immediately after re-
viewing the Digidesign Registration Informa-
tion Card included with every Pro Tools system. 
Registering your purchase is the only way you 
become eligible to receive complimentary tech-
nical support and future upgrade offers. Regis-
tering is one of the most important steps to 
complete as a new user.

Gather Important Information

Digidesign wants to help you resolve problems 
as quickly and efficiently as possible. If you have 
the following information handy when you 
contact Technical Support, it will make the diag-
nosis of your problem easier. Take a few minutes 
to collect the following basic information:

System Information

Computer

• Make, model, processor speed

• Amount of system RAM

• Operating system (version of Windows or 
Mac OS)

• Any Drivers, Disk Utilities, or other system-
related applications you may have installed
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• Type of cards, interfaces, or peripherals

Hard Drives

• Make, Model

• Drive size (GB)

• Drive speed (RPM)

• Drive type (SCSI, FireWire, IDE/ATA)

• Utility used to format the drive

• Number and size of partitions on the drive

Digidesign Software

• Pro Tools software version

• Plug-in versions

• Other Digidesign software

• Additional plug-ins from Digidesign Devel-
opment Partners

Other Hardware

Refer to the manufacturer’s documentation for 
operational details. 

The most common hardware additions include:

• 1394 (FireWire) cards for Windows systems 
(manufacturer, model)

• Video Capture cards (manufacturer, model)

To verify that your hardware is qualified for use 
with your Pro Tools system, refer to the latest 
compatibility information on the Digidesign 
website (www.digidesign.com/compatibility).

If using a Mac, you can get data on your sys-
tem’s configuration with the System Profiler 
utility included with your computer. If using 
Windows, the free utility PC Wizard can be 
helpful in gathering data on the specs of 
your computer. See www.cpuid.com for 
details.
Other Software

If you are using other audio or video applica-
tions, refer to the manufacturer’s documenta-
tion for operational details.

Make note of any other software that was run-
ning when a problem occurred.

Diagnostic Information

Note any DAE errors or other error codes you en-
counter. Additionally, note the ability to repro-
duce the problem under different conditions, 
for example, with another session, or after 
changing settings (such as the Hardware Buffer 
Size). 
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Chapter 14: Resources
Whether you are new to Pro Tools or just start-
ing out with your new system, we encourage 
you to read and utilize the many guides that 
Pro Tools provides. There are also useful online 
resources available, giving you everything from 
Pro Tools tips to Pro Tools answers.

About the Pro Tools Guides
In addition to any printed guides included with 
your system, PDF versions of the printed guides 
and many additional Pro Tools guides and Read 
Mes are installed automatically during Pro Tools 
installation (see “Documentation Installed Au-
tomatically with Pro Tools” on page 110). 

Printed Setup Guide

This printed Setup Guide for your system gives 
you detailed instructions for setting up and con-
figuring software and hardware for optimum 
performance, as well as in-depth instructions on 
using the guitar processor in Eleven Rack.

Printed copies of the Pro Tools Reference 
Guide and other guides in the Pro Tools guide 
set can be purchased separately from the Di-
giStore (www.digidesign.com).
Printed Getting Started with 
Pro Tools Guide

The printed Eleven Rack & Pro Tools Guide has tu-
torials on using Pro Tools (such as recording in a 
Pro Tools session, importing audio from a CD, 
and creating an audio CD from a Pro Tools ses-
sion).

Guides Accessible in Pro Tools

The main Pro Tools guides are accessible from 
the Pro Tools Help menu. (Choose Help, then se-
lect a guide.)

These include:

• Shortcuts Guide, which provides a complete list 
of keyboard and Right-click shortcuts for 
Pro Tools.

• DigiRack Plug-ins Guide, which describes the 
DigiRack plug-ins included with Pro Tools for 
both real-time and file-based audio process-
ing.

• Pro Tools Menus Guide, which covers all the 
Pro Tools on-screen menus.

• Pro Tools Reference Guide, which explains 
Pro Tools software in detail. 
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Documentation Installed 
Automatically with Pro Tools

When you install Pro Tools, you get useful PDF 
versions of many Pro Tools guides and 
Read Mes. This documentation can be found in 
the following locations:

Mac Applications/Digidesign/Documentation

Windows  C:\Program Files\Digidesign\
Documentation

Read Me Files

These contain late-breaking information and 
known issues pertaining to Pro Tools software 
and hardware configurations. Read Me files are 
installed in Documentation folder when you in-
stall Pro Tools.

About www.digidesign.com
The Digidesign website (www.digidesign.com) is 
your best online source for information to help 
you get the most out of your Pro Tools system. 
The following are just a few of the services and 
features available. 

Product Registration Register your purchase on-
line. 

Support and Downloads Contact Digidesign 
Technical Support or Customer Service; down-
load software updates and the latest online 
manuals; browse the Compatibility documents 
for system requirements; search the online An-
swerbase; or join the worldwide Pro Tools com-
munity on the Digidesign User Conference. 

To view or print PDF guides, you can use 
Adobe Reader or Apple Preview (Mac only).
Eleven Rack User Guide
Training and Education Study on your own using 
courses available online or find out how you can 
learn in a classroom setting at a certified 
Pro Tools training center. 

Products and Developers Learn about Digidesign 
products; download demo software or learn 
about our Development Partners and their plug-
ins, applications, and hardware. 

News and Events Get the latest news from 
Digidesign or sign up for a Pro Tools demo.

Pro Tools Accelerated Videos Watch the series of 
free tutorial videos. Accelerated Videos are de-
signed to help you get up and running with 
Pro Tools and its plug-ins quickly.

Helpful Online Resources

Once you get going, here are some helpful on-
line resources:

• Get useful information, help, and tips from 
the worldwide community of Pro Tools users 
at Digidesign User Conference (DUC). Go to: 
http://duc.digidesign.com

• For questions about installation, visit 
Digidesign’s online Answerbase. Go to: 
http://www.digidesign.com/answerbase

• If you can’t find your answer on the DUC or 
Answerbase, contact Digidesign 
email support. Go to:
http://www.digidesign.com/tsr
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modulation 28
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www.digidesign.com
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